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Chapter 1: About the Printer

Driver

The Card Printer Driver uses Microsoft XPS print technology to
support printing from currently available applications. This chapter
provides a task overview of what the Card Printer Driver does, and
a description of the communication between the Card Printer
Driver and the card printer.

Supported Operating Systems

The following operating systems are supported by the Card Printer Driver:

Windows XP
Windows 7

Windows 8

Windows Server 2003

Windows Server 2008

The Card Printer Driver also can be installed on systems running Windows Vista.

For more information on PC and operating system requirements, refer to the
printer’s Installation and Administrator’s Guide.

Because the Card Printer Driver supports multiple Windows operating systems,
the procedures in this Guide assume you can navigate to the appropriate
Windows panels for your system. The Guide describes how to set up and use the
Card Printer Driver from the appropriate window (for example, Printer
Properties). Operating system-specific exceptions are noted, where necessary.

Driver Task Overview

Refer to “Installing the Driver” on page 8 for the steps to follow to install the
printer and driver.

Once installed, the Card Printer Driver:

1.
2.

3.

Receives card data from an application.
Processes it for personalizing a card.

Optionally, encrypts data transactions with the printer for secure printing.
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4. Sends the prepared data to the printer.
5. Checks the printer for card completion.

6. Displays any conditions (messages) associated with the card job.

Printer/Driver Communication

The printer communicates with the PC via the Card Printer Driver using either a
USB cable or an Ethernet cable. For both connection types, the printer treats
communication as if the PC is connected over a network. Each printer has a
separate instance of the Card Printer Driver.

= You can update printer settings using the printer’s Printer Manager webpage.
Refer to the printer’s Installation and Administrator’s Guide for more
information on using the Printer Manager.

< You can customize applications to communicate with the printer through the
Card Printer Driver. If you use a customized application, follow the
instructions in your application.

e Secure printing is available on current models of SD, CD and CE series printers.
These printers have the capability to transmit print data using the
DPCL2 Secure printer command language. Print jobs are secured with data
protection automatically when a print request is sent to the secure printer
port (9111). For details, refer to “Using the Card Printer Driver for Secure
Printing” on page 18.

Printer/Driver Communications Over a Network

The Card Printer Driver requires the current printer IP address when it is
connected to the printer over a network. Refer to the printer’s User’s Guide for
information on how to retrieve the printer’s IP address.

When both printer and PC use an organization's network, the network affects the
speed of data transmission, and can affect who can use the printer. The network
printer can have many PCs connected to it, and each PC can be connected to
multiple printers over the network.

2 About the Printer Driver



Printer/Driver Communications Using a USB Connection

Connecting the printer and a PC using a USB cable automatically creates a local
network. Each time another printer is connected to the PC, a new local network is
created for the new printer.

You can connect up to eight printers to a PC using USB cables.

o The printer requires a USB 2.0 connection.

XPS Card Printer Driver Guide 3
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Chapter 2: XPS Card Printer
Driver Installation

This chapter provides information about installing
the Card Printer Driver.

Before You Install

The Card Printer Driver typically is installed using the installation CD shipped with
the printer. You also can install it using a downloaded installation file.

Be aware of the following before installing the Card Printer Driver.
« Load the printer ribbon and cards before installing the Card Printer Driver.

= The Card Printer Driver installation assigns a default printer name. Each
printer must have a different name. The installation handles this requirement.

If your site plans to implement printer sharing, have a printer naming plan in
place before installing the Card Printer Driver. You cannot rename a printer
after sharing is enabled. Refer to “Implementing Printer Sharing” on page
22 for more information.

= If you plan to use secure printing, install the Card Printer Driver on a PC that is
connected to a printer that supports secure printing. Refer to “Using the Card
Printer Driver for Secure Printing” on page 18 for more information.

Installation Overview

Basic installation includes the following steps:

1. Selecting Your Installation Method on page 6

2. Installing the Card Printer Driver using one of the following:
< Install Using the Driver Installation CD on page 7
= Install Without the Driver Installation CD on page 8

3. Installing the driver based on the printer/PC communication method you are
using, either USB or a network connection. Refer to “Installing the Driver”
on page 8.

XPS Card Printer Driver Guide 5



Advanced printer setup consists of:

Connecting More Than One Printer on page 16
Using the Card Printer Driver for Secure Printing on page 18
Implementing Printer Sharing on page 22

Implementing Printer Pooling on page 26

Selecting Your Installation Method

Your installation method depends on how many users print to the card printer,
the operating system you use to send card data, and other decisions specific to
your environment.

Choose from the following installation methods:

Use Driver
Installation
CD

The printer ships with a CD in the printer carton. In most cases,
install the Card Printer Driver from the CD. Refer to “Install Using
the Driver Installation CD” on page 7.

Download
the Driver

If you do not have access to the installation CD, download the
Card Printer Driver and install it. Refer to “Install Without the
Driver Installation CD” on page 8.

Use a USB
Connection

Refer to “Installing the Driver” on page 8.

Use a
Network
Connection

Refer to “Installing the Driver” on page 8.

Use Secure
Printing

Refer to “Using the Card Printer Driver for Secure Printing” on
page 18.

Do not install or share non-secure printers on PCs where secure
printing is required. To enable secure printing, install the latest
SD, CD, or CE series printer that has secure printing capability.

Connectto
More Than
One Printer

Refer to “Connecting More Than One Printer” on page 16.

XPS Card Printer Driver Installation



Use Printer
Sharing

Printer sharing allows one or more PCs (clients) to print cards to
a printer installed on a different PC (host). Refer to
“Implementing Printer Sharing” on page 22.

Use Printer
Pooling

A printer pool is a group of printers that act as one printer. Print
jobs are sent to the pool and are distributed among the
available printers.

Refer to “Implementing Printer Pooling” on page 26 and
“Setting Up a Printer Pool” on page 29.

Installing the Card Printer Driver

This section provides information about installing the Card Printer Driver on a PC
running a supported Windows operating system. Refer to “Supported Operating
Systems” on page 1 and the printer's Installation and Administrator's Guide for

complete information on installation requirements.

Begin the Card Printer Driver installation using the Driver Installation CD, or use a
downloaded installation file if the CD is not available.

Then, install the printer based on the printer/PC communication method you are
using, either a USB or a network connection. Refer to “Installing the Driver” on

page 8.

Install Using the Driver Installation CD

The printer ships with the Card Printer Driver’s Installation CD in the printer
carton. In most cases, install the Card Printer Driver from the Installation CD.

1. Logon tothe PC as a user with administrator access.

2. Insert the driver Installation CD in the PC’s drive. If the Autoplay dialog box
displays, click Run autorun.exe. After a few moments the driver install
Welcome page displays.

3. Continue with the driver install. Refer to “Installing the Driver” on page 8.

XPS Card Printer Driver Guide



Install Without the Driver Installation CD

Your network might prevent the download or installation of the Card Printer
Driver’s installation file. Ask your network support personnel for help when
downloading this file and when installing the Card Printer Driver.

If you do not have access to the Card Printer Driver Installation CD, do the
following:

1. Logon tothe PC as a user with administrator access.

2. Obtain the driver download file on a portable storage medium and save it to
your hard drive. If necessary, download the driver file from the website:

http://www.datacard.com

A. Browse to the Downloads area of the website (or the Products page for
the printer) and select the driver for your printer.

B. When the File Download dialog displays, click Save As.
C. Choose a location on your PC, such as C:\Temp, and click Save.
3. Browse to the location of the file saved in Step 2 on your PC.

4. Double-click the downloaded file. The file has a name similar to
XPSCardPrinter_"version".exe. The Welcome page displays.

5. Continue with the Installing the Driver.
Installing the Driver

The following instructions describe how to install the driver using either a USB or
a network connection. Most of the installation procedure is the same for either
method; differences are noted where necessary.

': Caution: If you are installing the driver with a USB connection, do not
connect the USB cable to the printer until instructed. If you start this
procedure with the USB cable connected, problems can result.

8 XPS Card Printer Driver Installation



1. Plugin and power on the printer. The LCD screen displays READY when the
printer is completely powered on.

2. On the driver install Welcome page, click Install a USB Printer or Install a
Network Printer.

i 2} Distacard XP5 Card Printer Installation

|

Waelcome to the XPS Card Printer
Instalier

Install a Network Printer
Install a USB Printer

Datacard’

XPS Card Printer Driver Guide



3. The Card Printer Driver installer displays the license agreement:

EMD-USER LICEMNSE SGREEMENT FOR DaTaCamD |2
CORPORATION S0FTWARE & FIRMWARE K
Accapt EULA
IMPORTANT-READ CAREFULLY: This End-Uszer
License Agreemant CELILA™) IS 3 legally-Binding
Prepars Computer conlrad between you (the licensee, vither a5 an
Indiddual or 3 conporate entity) and DalaCard
Cerporation (ihe Licensor refemed to 83 "Datacard’)
Tor the software M3t accompanies this ELILA,
assnciated media, documenton amd any Gromwane
Print Sample Card [eollgctively, e “Software”). For purposes ol this
ELILA e term Dratacard shall include whare

nstall Driver

apphkcabie the licansors of Datacard, who shall be

third ity beneSczbes heseol IFY0OL DD HOT

AGREE TO THE TERMS AND CONDITIONS

CONTAINED IN THIS EULAYOUW MUST COMPLETELY
REMOVE THE S0F TWARE FROM THE COMFUTER | )

[Print EULA o Aooept

o —)

A. Read the license agreement and select Accept.

B. Click the blue arrow on the right to continue.

The Card Printer Driver begins loading.

Preparing Computer

Copying driver fles...
Acceapt EULA

Prepare Computer
Install Diriver

Print Sample Card

101001190100

4. Confirm that the printer is powered on and the LCD screen displays READY.
Make sure that the cards and ribbon are loaded correctly.

o < If you are using a USB connection, continue with step 5.

= |f you are using a network connection, skip to step 6.
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5. When prompted, connect the printer to the PC using a USB cable, as shown

on your screen.

Accept EULA
Prepare Computer
Install Driver

Print Sample Card

The Card Printer Driver searches for the printer and connects the PC and

Watching for Printer...

> Plug in the USB data cable.

printer, displaying the Installing USB Driver page.

Accept EULA
Prepare Computer
Install Driver

Print Sample Card

.
J This will take about a minute.

Continue with step 10.

XPS Card Printer Driver Guide
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6. Connect the printer to the network using an Ethernet cable.

7. Use the printer LCD screen menu system to retrieve the printer’s IP address.
Refer to your printer’s User’s Guide for details on obtaining the IP address.

8. Enter the IP address.

A. Return to the Main Menu on the LCD screen.

Make sure that READY displays and the UseR button on the front panel glows
green. The Installing Network Driver page displays.

Installing Metwork Driver

-
. tnxlailing. please wail...

Accept EULA
Prepare Computer

Install Driver

Print Sample Card
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B. When the installer displays the Printer Properties Ports tab, click Configure

Port and type the IP address in the Printer Name or IP Address field.

0 P

I‘ o | Shemg| Pots | Advanced | Celor Mermgmmers | Securty | Dewoe Setrgn | feu
i

XPE Cordd Printer
| =

Bront tu thee follnssing partis), Descurmnts il piied tu the first free
checksd port.
Fort Descnption Printer

Fuiriiess Part
r  SerialPort

€l Z:  Sevial Pan

Serial Port

Serial Port

ComPqu Standed TCP/P Fen Uhemrice
r

|7 Pt St

|
| Port hiama: [P0 Faetswos Peat

| Provies Surne o P Aarieess fﬁ i:.
-
-
-

Pratucel
= Baw © PR

Lo —
Fart Sk [eana

- PR Sty

™ S Seamen fnabied

[

In some cases, the Port Number changes when you enter the printer’s IP address.

The printer uses Port 9100. If a number other than 9100 displays in the Port
Number field, delete the number and enter 9100.

9. Click OK and close the window.

Continue with step 10.

XPS Card Printer Driver Guide
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10. If you have ID software installed on your computer, the Install the Plug-In
screen displays when the Card Printer Driver installation completes. Click Yes
and follow the installation process to install the XPS Card Printer plug-in.

Install the plug-in for your ID software?

Thi plug-n allowi you 1o uie your 1D

Software’s sdvancad card-design features Waould you like to instail o update
such as magnetc stnpe and smar card) the XPS5 Card Printer plug-in for

to interface with this printer your 1D softwarc?

The plug-in can be installed 3t a later time
from the dever support Bles page of this
ristaler.

Datacard

When the Card Printer Driver and any plug-in software are installed, the
Installation Complete page displays.

Installation Complete

Printer. ¥PE Card Primter
Accept EULA

v
Prepare Computer “ |" - =
1]

[ ] i i

6 Print Sampla Card

Install Driver

Print Sample Card

11. Test your printer by printing a sample card. Make sure that READY displays on
the LCD screen, and click Print Sample Card.

For complete information on how to print a sample card or a printer test card,
refer to the printer’s Installation and Administrator’s Guide.
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12. If necessary, you can install additional support files by clicking
the second icon (upper left) on the Welcome page, and
selecting the items you want to install (such as Magnetic
stripe fonts and the Printer Plug-In, if you didn’t install it
when asked). Refer to “Installing the Support Files from the
Driver CD” for more information.

Installing the Support Files from the Driver CD

1. Insert the Card Printer Driver Installation CD and follow the prompts. The Card
Printer Installation window displays.

2. Select the Install driver support items icon (see right).
(Hover the mouse cursor over the icons at the top of the
installation window to find this icon.) The support items
window displays.

3. Select each of the support options you want to install and
click Install now. You can select from the following options:

o You may use the installation CD or the file downloaded from the website.

< Windows XP driver support — for Windows XP only—For shared printers
at client PCs, you must install the Windows XP driver support files (Service
Pack 3) on the client PC.

= Magnetic stripe fonts—Select this option if the client PC is processing
magnetic stripe cards using magnetic stripe fonts.

< ID Application XPS Card Printer Plug-in—Install the plug-in, if necessary. A
wizard displays and guides you through installing the plug-in.

< Legacy Support—Select this option if you have an application that uses
magnetic stripe fonts from older generation desktop printers.

4. After you install the needed support files, close the Card Printer Installation
window.

XPS Card Printer Driver Guide 15



Installing User Documentation

Install the card printer documentation files from the separate documentation CD.
The document set consists of:

* Quick Install Guide

= XPS Card Printer Driver Guide

e User’s Guide

= Installation and Administrator’s Guide
e QOpenCard Data Format Guide

= Software Development Kit (SDK)

Advanced Setup

Advanced setup options help you set up your installation to fit your operation’s
needs. Advanced setup includes the following:

Connecting More Than One Printer
Using the Card Printer Driver for Secure Printing on page 18
Implementing Printer Sharing on page 22

Implementing Printer Pooling on page 26

Connecting More Than One Printer

16

There are several options for connecting more than one printer to a PC. You can
connect to several printers installed on an Ethernet network, or connect multiple
printers to a PC using USB cables.

Use the following guidelines to install more than one printer using USB cables:

« Connect and install one printer at a time. The PC cannot run more than one
installation program at a time.

= You can connect up to eight printers to a PC using USB cables.

« |f you need to connect two card printers to a PC with one USB port, use an
independently powered, high-speed USB hub (USB 2.0) to which both printers
can connect. Do not daisy-chain multiple hubs. (Self-powered hubs are
recommended.)

e Each printer must remain powered on and in the READY state during
installation.

XPS Card Printer Driver Installation



Installing Additional USB Printers

For each USB printer installed after the initial USB installation, do the following:

1.

Load supplies and power on the printer before starting the installation. Refer
to the printer’s User’s Guide for the steps to load cards and ribbon.

Log on to the PC as a user with administrator access.
Connect the READY printer to the PC using a USB cable.

The operating system detects the new device and begins installation.
Depending on your system’s current setup, what you see during the
installation process varies:

e A pop-up window may display during installation.

If the operating system does not display a pop-up window within a few
minutes, check all cables and connections to the printer, and then look at
the PC’s Printers window to determine whether the icon for the new
printer is displayed. The software sometimes installs without displaying
the pop-up window.

= The operating system usually uses the existing Card Printer Driver files to
install the driver for this printer. Insert the driver Installation CD only if you
are prompted for it.

Using More Than One Printer on a PC

When using more than one printer on a PC, keep the following in mind:

Keep track of the printer names. When messages display, the title bar of the
message box displays the name of the printer causing the message.

Select the printer to use from within the card production application.
Card jobs are sent to the selected printer even if more than one card printer is
attached to the PC.

Each printer has its own icon in the Printers window, and each printer has
separate Properties and Printing Preferences windows. Settings are not shared
among printers.

Do not mix non-secure and secure printers on PCs where that requires secure
printing.

XPS Card Printer Driver Guide 17



Using the Card Printer Driver for Secure Printing

Secure printing consists of encrypting print commands and card data and
transmitting the information securely from the PC to the printer.

Secure Printing Overview

Datacard data security protects print data from unwanted interception or
alteration. Print jobs are protected automatically when a print request is sent to
a Datacard printer enabled for secure printing.

For information on setting up and enabling secure card printing, refer to “Using
Secure Printing” on page 20.

Driver Data Encryption

The Card Printer Driver uses the Secure Sockets Layer (SSL) and the Transport
Layer Security (TLS) data security protocols to encrypt both the print commands
and the card data that make up the digital print job.

Secure Sockets Layer (SSL) and Transport Layer Security (TLS)

SSL uses public-and-private key encryption. The SSL protocol effectively creates a
secure channel for sending the print job data between the PC and printer.

The SSL certificate exchange feature is not supported by the Card Printer Driver.
Protection of print data is supported by the SSL/TLS public-and-private key
encryption.

Standard SSL creates a level of encryption based on the client Web browser, the
operating system, and the host server’s capabilities. In the case of Card Printer
Driver secure printing, the client Web browser is the Card Printer Driver, and the
host Web server is the printer, as shown in the following illustration.

The browser requests that the web server identify itself. - P
- B

- B
The server sends back a digitally signed acknowledgement to ’W
start an S5L encrypted session. Z =

—_—
BROWSER - BEEE .
% p 3T Encrypted data is shared between the browser and the server. i

Transport Layer Security (TLS) uses stronger encryption algorithms and has the
ability to work on different ports.

18 XPS Card Printer Driver Installation



SSL/TLS Components

The Card Printer Driver uses a Microsoft Windows Internet application
programing interface (API) for the SSL encryption.

When the Card Printer Driver detects that the printer is capable of
communicating securely, it encrypts and sends all data using SSL/TLS across the
network to the printer’s https port 9111. Port 9111 is reserved for “DPCL2
Secure” printer language transmissions. Port 9100 is used for non-secure DPCL2
transmissions.

Driver Secure and Non-Secure Communications

Communication is configured to use one of three communication protocols.
These protocols are named for the printer command language protocols used to
send card print data between the Card Printer Driver and the printer.

Non-Secure Printing: DPCL and DPCL2 Protocols

DPCL s a first-generation non-secure printer command language protocol used to
transmit card print data.

DPCL2 is a second-generation of the non-secure DPCL communication protocol,
reporting additional options to the Card Printer Driver. The Card Printer Driver
displays some of these options on the driver’s Windows Printer Properties pages
for job processing logic and for reporting to applications via the driver SDK.

Non-secure printing is activated automatically for printers that do not have
secure printing capability or are not configured to use secure printing. Non-
secure printing does not provide SSL encryption.

Secure Printing: DPCL2 Secure Protocol

The Card Printer Driver uses DPCL2 Secure as the printer’s secure
communications protocol. During card production, the Card Printer Driver
automatically detects when a printer has DPCL2 Secure enabled.

DPCL2 Secure communication is enabled (or disabled) through the printer’s
Printer Manager Web interface. Refer to the printer’s Installation and
Administrator’s Guide for complete information on using the Printer Manager.

XPS Card Printer Driver Guide 19



Once secure printing is enabled through the Printer Manager, the Card Printer
Driver automatically uses the most secure protocol the printer is configured to
support. When the printer is configured to use DPCL2 Secure, the Windows
Printer Properties>Printer Status page display “Version 2 Secure” as the
protocol.

o Secure printing must be enabled for all current Datacard SD260L, SD360, CD800 and
CD870 card printers. (Earlier models of these printers do not offer secure printing.)

o Printers that provide only DPCL or DPCL2 non-secure printing may be part of
your network. Be sure to identify which printers provide secure printing and
which provide non-secure printing. Do not install or share non-secure printers on
PCs where secure printing is required.

The secure print process passes through the following phases in the background:

1. The Card Printer Driver automatically detects whether the printer supports
DPCL2 Secure or non-secure DPCL2 language protocol and sends the print job
using the most secure method the printer supports. If neither of these is
supported, the Card Printer Driver uses the legacy non-secure DPCL protocol.

2. If the printer is configured to use the DPCL2 Secure protocol, the job passes
through the SSL and cryptographic processing.

3. Once the data passes the encryption phase, it is passed through the network
to the card printer.

4. The print job prints out at the card printer.
Using Secure Printing

Secure Datacard Printers

Datacard models SD260L, SD360, CD800, and CD870 printers have built-in secure
printing capability that you enable using the Printer Manager. Earlier models of
these printers and the SD260 do not support secure printing.

Non-secure printers include the SD260 or earlier models of SD and CD series
printers that handle only non-secure printing, as well as current models of SD and
CD printers that are not enabled for secure printing in the Printer Manager.

Do not install a mix of secure and non-secure printers on one PC where secure
printing is required. If you install and set up secure and non-secure printers on the
same PC, you run the risk of users failing to select a secure printer when needed.

20 XPS Card Printer Driver Installation



Planning for Secure Printing

Before you install your card printers, develop a plan for secure printing. Decide
who needs to use secure printing and which printers (in which locations) to use.
This allows you to tailor the Windows Printer Properties security setup to your
organization’s needs.

1.

2.

Identify which user accounts you want to do the following:

< Allow to print. Write down names and user account names.

< Manage secure printing.

= Use non-secure printing.

= Manage shared printing.

Identify each card printer and its security capability (secure or non-secure).

« For secure printing, look for current models of Datacard SD260L, SD360,
CD800, and CD870 printers.

= Write down their device names.

< |dentify the card printer devices you want to share.

Setting Up Secure Printing

Do the following to set up secure printing:

4.

5.

Install a printer that supports secure printing. Refer to the printer’s
Installation and Administrator’s Guide for a list of hardware and software
requirements.

Install and set up the Card Printer Driver. Refer to “Installing the Driver” on
page 8.

Use the Printer Manager to enable secure printing. Sign on as a WebAdmin
and select Printer Setting >Behavior. Select Enabled for the DPCL2Secure
option. Refer to the printer’s Installation and Administrator’s Guide for
complete information on using the Printer Manager.

Restart the printer and computer for the setting to take effect.

Connect Datacard’s secure printers to host and client PCs.

After secure printing is set up, the Card Printer Driver automatically detects and
uses secure printing during card production.
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Implementing Printer Sharing

You can share a printer over a network using Microsoft File and Printer Sharing.

Shared printing includes a host PC and up to 10 client PCs. The printer is
connected to a host PC that has the Card Printer Driver installed. Client PCs then
print to the shared printer over a network. Client PCs do not have the same level
of access to the Card Printer Driver as the host PC.

Printer Sharing Requirements

22

Before sharing a printer over a network, make sure that the following
requirements are met:

= Each PC that uses the printer must be connected to the same network,
workgroup, or domain.

o Windows XP does not support sharing between computers on a domain.

= The host and the client PC must be using the same type of processor, either
32- or 64-bit.

 The host PC must be configured and enabled for sharing.

e The host PC must remain on at all times with the Windows operating system
running.

« The host PC must grant permissions for users that print to the shared printer.

= [f you need to rename a printer, do it before you enable printer sharing.

Renaming shared printers is not supported. Do not change printer names once
sharing is enabled. If you rename a shared printer, print requests may fail and
reinstallation may be necessary.
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Supported Operating Systems

The Card Printer Driver supports the following host and client operating system
combinations. See the appropriate appendix for printer sharing setup
information for your host and client systems.

Host Client Refer to

64-bit: 64-bit: Appendix A: Windows 7 and
Windows 7 Windows 7 Windows 8 Printer Sharing
Windows 8 Windows 8

Windows XP, 32-bit

Windows XP, 32-bit | Appendix B: Windows XP Printer

Sharing

Windows Server 32-bit: Appendix C: Windows Server 2003
2003, 32-bit windows XP Printer Sharing

Windows 7

Windows 8
Windows Server 64-bit: Appendix D: Windows Server 2008
2008, 64-bit windows 7 Printer Sharing

Windows 8

Tips for Host PC and Client PC Users

The user at the host PC has more control over the printer. The host PC typically is
located near the printer and is used by administrator-level users. This section
describes some tasks performed at the host PC.

Understanding these tips for setting up and managing shared printers can help
you install and change your printer setup for your operation’s unique needs.

Feature Printer Sharing Tips
Host PC Users:
Manage Use the Windows Print Manager to manage print jobs.
print queue
Secure To ensure secure printing, make sure that:
printing = The printer you install and share is a secure printer.

= Secure printing is enabled in Printer Manager.

Refer to “Using the Card Printer Driver for Secure
Printing” on page 18.
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Feature

Printer Sharing Tips

Security
permissions for
shared printers

Set up a Windows group account with the users who
have the same printer Security permissions.

For more information, refer to:
“Set Up Group Accounts for Using Shared Printers” on
page 25.

Setup to view
Message boxes

To set up accounts to view Message boxes.

= Enable printer sharing on the Windows Printer
Properties Sharing tab.

= Set up applicable user accounts on the Windows
Printer Properties Security tab. Select the Print and
the Manage this printer permissions for each user or
group. Selecting both of these settings lets individual
users or groups print and view Message boxes from
their PCs, except as noted below.

For a Windows XP or Windows Server 2003 host: Client
PCs cannot view message boxes. These client PCs must
open the Windows Print Manager. Users of these client
PCs may need to resolve printer errors at the printer.

View printer status,
supplies, and card
counts

(Windows XP: View only at the host PC.)

For more information, refer to the applicable topic:
= Viewing Printer Status on page 37
= Viewing Printer Supplies on page 39
= Viewing Card Counts From the PC on page 40

Client PC Users:

Client

Card Design
Printing
Preferences

Client PC users have different options for high-resolution
printing.
= Client PC users don’t have the Always use best
possible resolution setting.

* Client PC Users must choose the supported
resolution under Custom.

Refer to “If the Windows Print Manager is already
open, press F5 to update the current print job status in
the Print Manager window.” on page 26.
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Feature

Printer Sharing Tips

Allow printing and
viewing of
Message boxes

Client PC users may be able to view printer messages.
The buttons on Message boxes let users resolve some
issues without going to the printer.

Refer to the “Configure Security” instructions in each of
the appendixes for installing the printer at client PCs.

All PC Users:

Clear error
messages on the
printer or host PC

If you clear the error at the printer’s LCD screen, the error
message on the PC closes automatically and removes
the error message from the Windows Print Manager.

Don’t print

to shared

printers in
interactive mode

Host and client PCs cannot use shared printers in
interactive mode.

This restriction prevents using operations such as
magnetic stripe reading or smart card personalization.

Note: Shared printers are not supported when jobs are
submitted using the driver Software Developer Kit (SDK).
For more information on using the SDK for card design,
refer to the printer's Installation and Administrator's
Guide.

Update job status
in the Windows
Print Manager

If the Windows Print Manager is already open, press F5 to
update the current print job status in the window.

Use device
naming rules for
shared printers

Don’t rename a shared printer. Doing so means all
connected printers may need to be reinstalled at host
and client PCs.

Note: Renaming printers after implementing printer
sharing is not supported.

Set Up Group Accounts for Using Shared Printers

If you want to define which users can both print cards and view message boxes,
Datacard recommends that you create a group account. Assign the client user
accounts allowed to use the printer to the group account. Then, using the shared
printer’s Printer Properties Security tab, select the Print and Manage this printer
permissions to allow the group to print and display Message boxes.
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For more information, refer to the Microsoft documentation on setting up group
accounts and printer security permissions, and the following instructions for your
configuration:

e Appendix A: Windows 7 and Windows 8 Printer Sharing
« Appendix B: Windows XP Printer Sharing
= Appendix C: Windows Server 2003 Printer Sharing

e Appendix D: Windows Server 2008 Printer Sharing
Windows Print Manager

The Windows _
Print Manageris ~ |fo= s
one tool available || s s e g T
for managing f

print jobs across (e ——
your host and

client systems. Do not confuse the Windows Print Manager (shown) with the
printer’s Printer Manager.

If the Windows Print Manager is already open, press F5 to update the current
print job status in the Print Manager window.

Implementing Printer Pooling

Printer pooling is used in card production environments in which an application
prints to a group of printers. The user chooses to print to the pool and the pool
distributes the print jobs to the next available printer.

Printer Pooling Requirements on page 27
e QOperating Systems Supported for Printer Pooling on page 28

e Tips for Printer Pooling on page 28

Setting Up a Printer Pool on page 29
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Printer Pooling Requirements

Printer pooling requires that you set up all printers in a pool with the same basic
setup except as noted below. The setup includes connecting printers using an
Ethernet cable only, using the same ribbons, and setting up for non-interactive
printing.

All printers in a printer pool

must have the same: With:

Model number The same printing features installed, as
outlined in this table.

Examples:

A poolincludes: Note Do not place non-secure printers in

Only SD260L models pools where secure printing is needed. For

OR Only SD360 models more information about secure printing,

OR Only SD800 models refer to “Using the Card Printer Driver for
Secure Printing” on page 18.

Supplies The same settings applied. For instructions

to set up printer ribbons, resolution, and so
on, refer to “Configuring PC Printing
Preferences” on page 47.

Network cable type—Ethernet | No USB-connected printers. Printer pooling

only is not supported for USB-connected
printers.

Non-interactive printing No direct, printer-to-PC processing is

requirements permitted. Interactive print processing

requires a connection to a printer, which is
not possible when using a pooled printer.

Note Smart card and magnetic stripe
read commands cannot be processed on
printers in a pool.

Printer Manager settings and Refer to the printer's Installation and
magnetic stripe values Administrator's Guide for more
information.

For instructions to set up printer pooling, refer to “Setting Up a Printer Pool” on
page 29.
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Operating Systems Supported for Printer Pooling

Printer pooling is supported on all Card Printer Driver-supported operating
systems. For more information on supported operating systems, refer to the
printer's Installation and Administrator's Guide.

Tips for Printer Pooling

Feature Tip for Printer Pooling

Error messages Messages display the name of the main
printer named during the Card Printer Driver
installation, rather than the name of the
specific printer in error.

« To locate the printer with the error
condition, look at each printer in the pool
for warning indicators or LCD messages.

= Card jobs are held at the printer with the
error condition. All subsequent card jobs
will print to other printers in the pool. The
printer with the error is not used by the
pool until the error condition is corrected.

= After correcting the error at the printer,
resume or cancel the print job using the
error message on the PC.

Printer Pooling Printer status, card count, and supplies
information information typically shown in the Windows
Printer Properties window is not available to
printers belonging to a printer pool.

For these printers, the Printer Properties
window displays Printer Pooling information,
which indicates that the printer belongs to a
printer pool.

Use the Printer Manager to view card counts,
supply information, and printer status of
individual printers in the pool. Refer to the
printer’s Installation and Administrator's Guide
for information about using the Printer
Manager.
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Feature Tip for Printer Pooling

Print Sample Card and The Print Sample Card and Magstripe Test
Magstripe Test Card not Card buttons on the Printer Properties window
available Status page are not available for a printer

belonging to a printer pool. Print sample cards
or test cards from the LCD screen on the
printer.

Printer pool print queues A printer that cannot process jobs continues
to have jobs assigned to it by the pool
controller. The Card Printer Driver does not
determine if each printer in the pool is ready
to receive card jobs.

= Remove printers that are not available
from the pool until they are functioning
and ready to receive print jobs.

= To remove a printer from the pool, open
Printer Properties and click the Ports tab.

= Remove the check from the port
assigned to the printer.

Some software, such as Microsoft Word, sends
multiple-card (batch) files as a single print job.
In this case, the pool sends all cards in the
batch to the same printer. Software designed
specifically for card production sends each
card in the batch as a single print job. The
printer pool distributes single print jobs among
the available printers.

Setting Up a Printer Pool

The following instructions describe how to set up printer pooling for all
supported Windows operating systems. Operating system-specific differences
are noted, where necessary. The screens shown may differ slightly from those on
your system

1. Install the first network printer on the host PC. Refer to “Installing the
Driver” on page 8.

2. Connect each additional printer you want to include in the pool to the
network using an Ethernet cable.

3. Write down the IP address of each printer. Refer to your printer’s User’s Guide
for details on obtaining the IP address.
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4. Configure the network printers for printer pooling.
A. Display the Printers window for your operating system.

B. Right-click the card printer icon and select [Printer] Properties to display
the Printer Properties window.

Windows Server 2008: Select the printer and select Print Server
Properties from the menu bar.

C. Select the Ports tab and click Add Port.

Windows Server 2008: Scroll down and highlight the printer to add to the
pool. Click Change Port Settings; then click Add Port.

The Printer Ports window displays (see below).
D. Select Standard TCP/IP . _ S

Port, and click New Port. bt 2;1 e

The Add Standard TCP/IP i zosndon

CutePDF Wriiter Moanilar

. H ocal P
Printer Port Wizard page T ——

displays. |

E. Follow the instructions in

the wizard to add the port. [ HewPonType. w oie |

Click Next to display each
step in the wizard.

£
|

F. Inthe Printer Name or IP PP e
Address field, enter the Mg T
name or IP address of the - - —
printer you are adding.

Enter the Printer Name o IF address, and a port ramse for the desired device.

Prirster Meme or [P Address 172160158

G. In the Port Name field, Pert Nome WP Poct - Ponter
enter a name, such as
Pooled Printer 2.

H. Click Next.

If the Additional Port <tucc || Hei: ] [ Cocd
Information Required page
displays, select Custom and click Next.

I. When the last page of the wizard displays, click Finish.
J. Repeat these steps for each printer you want to add to the pool.
K. Close the Printer Ports window.

L. Click Apply, if necessary, after all printers and ports have been added.
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5. Enable printer pooling.

A. Select the Ports tab if it is '5""“"'““ B S

not already open. Thelist |
of printer ports displays. R e e Pt Py e

B. SelectthePortcheckbox [
for the printer that will
represent the pool. (This
is the printer that users
select when printing to
the pool.)

C. Select Enable printer
pooling.

D. Select the Port check box next to each port you added and want to be part
of the printer pool.

E. Click Apply to save the settings.

6. Click OK to close the Printer Properties window.
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Chapter 3: Card Printer Driver
Management Tasks

Card Printer Driver managements tasks are accessed in the Card
Printer Driver through the Printer Properties window.

This chapter provides information about the Card Printer Driver, including:
e Using the Printer Properties Window
= Driver Management Tasks in Windows Printer Properties on page 37

e Uninstalling the Card Printer Driver on page 41

Using the Printer Properties Window

The Printer Properties window allows you to specify the settings and values that
Windows uses to communicate with and manage the printer. In addition to the
standard tabs used for all printers, the Printer Properties window for the Card
Printer Driver uses the following tabs for card printing:

e Security (Refer to “Setting Printer Permissions” on page 34.)
= Printer Status (Refer to “Viewing Printer Status” on page 37.)
* Card Counts (Refer to “Viewing Card Counts From the PC” on page 40.)

= Supplies (Refer to “Viewing Printer Supplies” on page 39.)

Displaying the Printer Properties Window

1. Open the Printers window on your PC.

2. On the Printers window, right-click the icon for the card printer and select
Printer properties from the pop-up menu. The Printer Properties window
displays.

o Windows 7 and Windows 8 include a Keep printed documents option on the Printer
Properties Advanced tab. The Card Printer Driver does not support this setting.
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Setting Printer Permissions

34

If the PC to which the printer is attached has more than one user, set permissions
that:

Give users access to all features of the printer and Card Printer Driver,
including messages.

Display messages to inform users when they need to change the ribbon, load
cards, or fix problems.

Prevent access to the printer by unauthorized users.

Log in to the PC as the Creator/Owner (Windows 7, Windows 8) or with
Administrator permissions (Windows XP).

On the Printer Properties window, select the Security tab.

A. Review the Group or User Names list. If the names for which you want to
specify permissions do not appear in the list, add the names.

B. Click Add to open the Users and Groups dialog box.

C. Select a name and click Add. Repeat for each name you want to add.
When done adding names, click OK to close the Users and Groups dialog
box.

In the Names list, select the name for which you want to specify permissions.
From the Permissions list, select the access the user or group should have:

A. To enable printing, select Allow for Print, Manage Printer, and Manage
Documents.

B. To prevent a user from printing to the card printer, select Deny for all
permissions.

Click Apply to save the changes.

Repeat steps 3 through 5 to grant access to the printer for other users or
groups.

Select OK to close the Printer Properties window.
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Viewing Network Information

When the printer and PC using the Card Printer Driver are connected using a
network, the network settings on the PC and the printer must match.

Use the Ports tab on Card Printer Driver Printer Properties window to enter the
printer’s IP address. Refer to the Port Type section of “Viewing Printer Status”
on page 37 to view the setting.

If the printer is set to use DHCP (Dynamic Host Configuration Protocol), the IP
address of the printer can change when the printer is powered off and powered
back on. If this occurs, the Card Printer Driver issues error message 500.

If the printer IP address changes often, use static IP addressing to provide a more
reliable connection. Work with your network support group to identify the IP
address, subnet mask, and gateway address (if used). Then, refer to the printer’s
Installation and Administrator’s Guide for setting the IP address type.

XPS Card Printer Driver Guide 35



Printing a Driver Sample Card
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The Card Printer Driver includes a sample card that shows a basic ID card. The
card can be printed with any ribbon the printer supports. The sample card verifies
that the Card Printer Driver and the printer are communicating. The images and
text do not change.

The Card Printer Driver also includes a magnetic

.

stripe test card, available when the printer '

includes a magnetic stripe option. The magnetic

stripe test card verifies that the Card Printer

Driver sends magnetic stripe data to the printer =

and that the printer encodes it. The data cannot T Vliam

be changed. Sl
nmhipmgsm 1] T SOMPANY

HINTS & Tips

= The magnetic stripe data sent by the Card
Printer Driver requires that the printer be set
to encode the three-track ISO format for a three-track module, or the JIS-I
format for the single-track module.

= Many driver settings in the Printer Preferences page (such as print area,
orientation, copies, hopper number, and so on) do not apply to the sample
card.

To print a sample card:
1. Open the Printer Properties window.

2. Select the Printer Status tab. The Status tab displays the printer status. If the
printer is not Ready or Busy, troubleshoot the problem.

3. Toprintasample card, do one of the S
following: T e e T e T

« Click Print Sample Card.

e Click Print Mag Stripe Test Card.

The printer picks the card and prints it.
If the card does not print, troubleshoot
the problem.

-
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Driver Management Tasks in Windows Printer
Properties

Use the Printer Properties window to view status information about the printer.

o The Ports tab of the Printer Properties window includes an Enable Bidirectional
Support check box. The Card Printer Driver always uses bidirectional communication
with the printer. Make sure that this option is selected; otherwise all printing from
the Card Printer Driver is disabled.

Viewing Printer Status

The Card Printer Driver Printer Status e —

tab displays the printer status, port e s
type, IP address, printer information, g =

and any messages that apply to the

printer.

1. On the Printer Properties window,
select the Printer Status tab.

The date and time the information P g o

was retrieved from the printer L —— —
displays in the lower left area of the
tab.

2. To get the latest information from the printer, click Ask Printer for Update.

3. You can update printer settings using the printer’s Printer Manager web
service. Click Configure Printer to log into the Printer Manager. Refer to your
printer’s Installation and Administrator’s Guide for complete information on
using the Printer Manager.

Printer Status

The printer status can display as one of the following:

Icon Printer Status

Ready
a The printer is not processing a card.

Suspended

I |J The printer was paused, or is processing a card from another PC
that has an error.
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Ilcon

Printer Status

Busy

The printer is processing a card or a command, or the printer
menu system is being used.

Message

If the printer has issued a message for a card sent from this PC,
the message text displays.

Initializing
The printer is powering on.

Unavailable
The printer is off, is shutting down, or is not connected.

Port Type

The Port Type displays as one of the following:

« USB for a locally connected printer. The printer IP address also displays.

= Network for a printer connected using a network connection. The printer IP
address also displays.

Printer Information

The Printer Information box shows the following:

Model

Serial Number

Model name of the printer

Printer serial number assigned at the factory

Firmware Version Build version of the firmware currently running in the
printer
Protocol DPCL protocol used by the driver to communicate with

the printer

Option Information Options or features included in this printer
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Viewing Printer Supplies

The Supplies tab of the Card Printer
Driver Printer Properties window shows
the type of ribbon installed, the
estimated percentage of ribbon
remaining, and any messages that
apply to the supplies and printer.

1. Open the Printer Properties window v
and click the Supplies tab.

2. The date and time the information
was retrieved from the printer displays in the lower left area of the tab. To get
the latest information from the printer, click Ask Printer for Update.

The Card Printer Driver Printer Supplies tab shows:

Icon Printer Status

OK
i The printer has ribbon, and at least 10% of the roll remains.

Low
The printer has ribbon, and less than 10% of the roll remains.

Unknown

The ribbon is missing or the printer is not processing a card. The
estimated percentage of ribbon remaining displays as 0%.

Ribbon Type

For supported ribbons, the type of ribbon, such as YMCKT or K, is
shown. ymcKT is short-panel ribbon.

If the ribbon is missing or is not a supported ribbon, Missing
displays.
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Viewing Card Counts From the PC

You can see card counts from the Printer Properties window.

1. On the Printer Properties window,
click the Card Counts tab. The tab
displays current and total counts.

2. Click Ask Printer for Update to see
the most recent card counts.

About card counts:

= Total shows all the cards the printer
has processed.

e Current shows all cards printed since
the last time the count was reset.
Current counts can be reset using
the Printer Manager.

| ey e | e | Le g |y P e S Dt e | s

e The printer only sends updated card counts when you click Ask Printer for

Update.

= The printer includes cards used for test cards and cleaning cards in the Cards
Picked count, but not in Cards Completed count.

= You cannot view card counts from a shared client PC.

Viewing the Driver Version

1. On the Printer Properties window, click the

About tab.

2. The About tab shows the Card Printer Driver
version and any additional information.

3. Click Close to close the Printer Properties

window.

40

Card Printer Driver Management Tasks



Uninstalling the Card Printer Driver

You can uninstall the Card Printer Driver either with or without the driver
installation media.

Uninstall the Driver with the Driver Installation CD or Web File

1. Logon to the PC as a user with administrator access.
2. Do one of the following:
= Insert the driver Installation CD in the PC’s drive.
= Double-click the XPSCardPrinter_"version".exe downloaded file.

The driver install Welcome page displays. (If the AutoPlay window displays,
click Run autorun.exe.)

3. Click the wastebasket icon to start the uninstall process.

4. The Remove the Printer Driver from the PC window displays. Click Remove
the Driver.

Py My e — o — . e

FET o

Remove the Printer Driver from the PC

IO s s i | Removs the Driver
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An activity indicator displays as the Card Printer Driver is being removed.

Remove the Printer Driver from the PC

Ramerving tha dibeer...

Datacard

A green check mark indicates that the Card Printer Driver has been removed.

2 Datacard %75 Card Pirvier bnitih i T e

Remove the Printer Driver from the PC

i L Unplg M peinder LIS cabde, o
o tid

o Duiver removed,

5. If the printer was connected via USB, unplug the USB cable.

6. Complete the uninstallation:

A. Click the home icon to return to the Welcome page.

B. Click Exit to close the Welcome page.
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Uninstall the Card Printer Driver Without the Driver

Installation Media

1. From the Windows Printers window, right-click the icon for the XPS Card
Printer and select Remove device from the pop-up menu. The XPS Card
Printer icon is removed from the list of printers.

Gy mver Al ajete sk peeiey P e gt B e

% Gl Pemilad Mool 1PN Cantl Somiee

s I
ﬁ R T T r————

2. From the Windows Start menu, select All Programs > Datacard Printers and

click XPS Card Printer Uninstall.

L Eeoadsom
| Carreetica
b Corgl DURGHER Technicsl Sapte 103
L D300 Saries
| Duiscurd Prinkees
3 WS Card Printer Urirrital
b Dirscekn
| Debugging Tocks fee Windows (454
L ininl
| hterides WinlWD
b Lighttoribes Dinect Ding Laibeling
| Lotus Appbestise
| Wisrésmancs
| Motter
| Micrcack Cffice
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Windows 8 users: On the Start screen, type XPS and select XPS Card Printer
Uninstall from the Search list, or select the XPS Card Printer Uninstall tile
from your Start screen.

-

KPS Card Pnnter
Uninstall

Click Yes when asked if you want to allow the program to make changes to
your computer.

3. The XPS Card Printer Uninstall dialog box displays. If the printer is installed with
a USB cable, make sure that the cable is connected to the PC. If the printer is
connected to an Ethernet network, you can continue with the uninstall. Click
OK to continue.

AP Card Frister

Check thal the USE cable i plegied in befose contitung this proces

The USE cable suit be phogged i fer the drrved 1o be domplddy
romeroed,

4. The XPS Card Printer Uninstall dialog box displays a warning that there will be
no printer activity while the Card Printer Driver files are being removed. Click
OK to continue.

Mo activity will be reperted mhile Srreet il ane being delebed

‘Wenn will bt nstifed when usisatall complite
I will take st 30 secends

ek O ne delete the desver flei.

[

5. When the XPS Card Printer Uninstall dialog box displays, the Card Printer
Driver is uninstalled. Unplug the USB cable, if needed. Click OK.

Unphuy the prister USE calile frov

oK

6. Restart your PC following the uninstall, if required.
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Chapter 4: Card Design Tasks

This chapter provides information about card design tasks you can
perform through the Card Printer Driver.

Use the following information to fine tune your card design and printing:
e Configuring PC Printing Preferences

e Design Tasks in Windows Printing Preferences on page 49

e Using Escapes on page 61

= Using Magnetic Stripe Fonts on page 68

Configuring PC Printing Preferences

The Printing Preferences window lets you set up your printing preferences.

o If you are using printer sharing, settings on the client PC, such as ribbon type and
print resolution, must be configured to match the settings of the host PC. Print
quality from the client PC may be affected if the Windows printing preferences and
printer properties are not the same on the host PC and the client PC.

Follow these steps to change the printing preferences settings.
1. Display the Printers window on your system.

2. Right-click the icon for the card printer and select Printing Preferences from
the menu.

When you set up the host PC, write down the settings you specify in the Printing
Preferences window. These are the settings you use when you set up each client
PC’s printing preferences.

3. Select the ribbon type options.
The host PC automatically detects and selects the ribbon type.

The client PC does not automatically detect the type of ribbon installed in the
printer. Instead, it defaults to YMCKT ribbon and 300 x 300 dpi resolution.

A. From the Printing preferences window, select the Layout tab and click
Advanced. The Advanced Options window displays.
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B. Select the type of ribbon from the Ribbon Type/Split-Ribbon Panels drop-
down list.

Write down the settings for the ribbon type on the host. When you set up
each client PC, select the same setting you selected on the host PC for the
ribbon type.

C. Click OK to close the Advanced Options window.
D. If you changed the settings, click Apply to store the changes.
4. Select topcoat and print blocking options.

A. Select the Print Area tab and select the desired options for the front side
and back side print areas.

B. If needed, from the drop-down list for Print and topcoat entire side of
card except, select the desired smart card or magnetic stripe option.

C. If you changed the settings, click Apply to store the changes.
5. Set the print resolution.
A. Select the Print Mode tab to display the Print resolution options

B. Select the desired print resolution. The Print Mode tab has the following
three options. (All options may not be available for all printers and appear
grayed out.)

= Always use standard resolution (300x300 dpi)—this is the default
value

= Always use best resolution (not available at a client PC)
e Custom

If the Custom option is available and you select it, select the
resolutions from the Color and Monochrome drop-down lists.

o For client PC setup, select the same setting you selected for the host PC
print resolution.

C. If you changed the settings, click Apply to store your changes.

6. Click OK to close the Printing Preferences window.
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Design Tasks in Windows Printing Preferences
Adjusting the Colors Printed

The Card Printer Driver for use with Windows operating systems allows you to
adjust the color printing on a card using the Printing Preferences window.

Using the Color Adjustment tab, you can change the following:
= The brightness of color printing on the card.
= The contrast of color printing on the card.

« The color balance of color printing on the card.

1. On the Printing Preferences window, [ 2% Cart Pt Pty orre P
select the Color Adjustment tab. e T Gt g

Bralin v it

The tab contains the original image e
and the adjusted image. They show -
how your changes might look on a -
card. -

2. Select Enable Color Adjustment, if
needed, to adjust the settings.

Brightness H

The Brightness setting changes the overall
lightness or darkness of the card.

1. Click the Up arrow to make the image
lighter, or the Down arrow to make the
image darker.

The Adjusted image shows the effect of
the new setting.

2. Click Apply after each change to save it.
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Contrast

3. To verify changes, do one of the following:

e Print one or more cards from the card production software.

e Print a sample card from the Printer Properties > Printer Status page.
4. Evaluate the appearance of the cards.
5. Repeat these steps until the cards meet your requirements.

6. Click Apply to save the new values.

The Contrast setting changes the degree
of difference between the light and dark
values of an image.

1. Click the Up arrow to increase
contrast, or the Down arrow to
decrease contrast.

The Adjusted image shows the effect
of the new setting.

2. Click Apply after each change to save
it.

3. To verify changes, do one of the following:

* Print one or more cards from the card production software.

e Print a sample card from the Printer Properties > Printer Status page.
4. Evaluate the appearance of the cards.
5. Repeat these steps until the cards meet your requirements.

6. Click Apply to save the new values.

Color Balance

50

1. Evaluate the image for color balance. Does the card have a yellow cast or do
photos have a greenish tint?

If most of the card prints with the correct colors, consider using a graphics
application to change the logo or other part of the card that needs color
improvement.
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Determine which color needs
adjustment.

Click Apply after each change to save it.

To verify changes, do one of the following:

Increase red, or decrease red to
add cyan (light blue).

Increase green, or decrease green
to add magenta (red-purple).

Increase blue, or decrease blue to
add yellow.

If changing the obvious color does
not produce the desired effect, try
changing the other two.

Click the Up arrow to increase a
color, or the Down arrow to
decrease the color.

The Adjusted image shows the effect of the new setting.

Print one or more cards from the card production software.

Print a sample card from the Printer Properties > Status page.

Evaluate the appearance of the cards.

Repeat these steps until the cards meet your requirements.

Click Apply to save the new values.

HINTS & Tips

+10

+10

+10

A

The settings on the Color Adjustment page affect the color printing of all cards

sent from the PC using the Card Printer Driver.
Printing formatted as black (K) is not affected by color adjustment.

Each click changes the setting by 1 percent (%).

To use adjusted colors on some cards but not others, clear the Enable Color

Adjustment selection before printing those cards that do not need the

adjustment.
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Changing a Card Design

52

Card design is the name given to the combined features of the printed cards.

An organization can change:

The arrangement of card components, such as moving a photo from the
center to the left side of the card.

The source for card components, such as using a different camera for taking
photos, or using a new file for a logo.

The components on the card, such as adding a magnetic stripe, logo, or bar
code.

Whenever the card design changes, review the settings used for the card. Use this
checklist to guide your changes. Always:

Use high-quality (300dpi) photos and graphics.
Print several samples of the updated card design.

Use cards with a magnetic stripe or bar code in a reader to verify the data
works as expected.

If changing a graphic on the card, the camera for taking photos, or the
location for taking photos, make sure to check the Color Adjustment setting.
Refer to “Color Printing” in your printer’s Installation and Administrator’s
Guide for information about how to improve the appearance on one element
on a card.

If changing a bar code or magnetic stripe, refer to your printer’s Installation
and Administrator’s Guide.
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Printing Cards Using Split-Panel Color Printing

Split-panel color printing lets you use fewer ribbons to print cards in color. It uses
a single panel set from a full-color ribbon to print each card, rather than two or
three panel sets. The ribbon can be a full-panel (YMCKT) or short-panel (ymcKT)
color ribbon.
Before using split-panel color printing, become familiar with the use of card printer
color printing. Refer to the printer’s Installation and Administrator’s Guide for
complete information on color printing.

Most types of cards, including cards with magnetic stripes and smart cards, can
be printed using split-panel printing. Features for color, monochrome, and
topcoating on the front side are available.

To apply split-panel color printing:

1. Display the Printing Preferences window, select the Layout tab, and click
Advanced.

2. Select the Split Ribbon Panels option.
3. Click Apply to save your settings.

4. Make sure that YMCKT or ymcKT ribbon is installed in the printer.
Encoding the Magnetic Stripe Without Printing

Using the Card Printer Driver, you can use the printer to encode magnetic stripe
data on a card without printing on it.

o If you are using card production software to produce cards, the following steps are
not necessary and you can use the settings in the software to encode without
printing.

1. Open the Card Printer Printing e
Preferences window. Select the : -
Layout tab and click Advanced.

Click Disable Printing, and select [==smis &) [=
All, s

2. Click OK to save the setting and & ;:. B
close the Advanced Options e
window.

3. On the Layout tab, click Apply.
Click OK to close the Card Printer Printing Preferences window.
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4. Format the data:

The Card Printer Driver discards 3 = S |
all printable data and sendsonly == B i
the magnetic stripe data to the -"-':_'__:_

T L
¥ Ea) fomb | TP Cand Pemile

printer. '

T At Bl

[ ST
¥ dwisl Rogrded W1 Boid
W ek L

Figne ¥

e If you are using card
production software, use a
magnetic stripe field if
available.

= Using other PC software, format the data using magstripe fonts or
magstripe escapes.

The sample card shown has the text Sports Arts formatted with a magnetic
stripe font. It is sent as encoded data. The other images and text on Page 1 are
discarded.

5. Send the card to the printer to test your setup.
HINTS & TIPS

You are responsible for using characters that the track format supports. Refer to
the printer’s Installation and Administrator’s Guide for magnetic stripe data
formatting information. For more information on using magnetic stripe escape
codes to format data, refer to “Using Magnetic Stripe Escape Codes” on page
64.
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Setting Up to Print on Both Sides of the Card

Using the Card Printer Driver, you can print on both sides of the card. The method
for printing on both sides depends on the printer model.

« Some printers include a duplex printing module that automatically turns the
card to print both sides. Check the configuration label located on the left side
of the printer to determine whether the printer includes a duplex module.
Refer to “Printer Configuration Label” in your printer’s User’s Guide for more
information.

< Simplex printers support manual duplex printing. The printer prints one side
of the card, places the card in the card output stacker, and displays a message
prompting you to insert the card into the hopper or manual-feed slot to print
on the second side.

Setting Up Manual Duplex Printing

Use card production software or another PC

By

application to create a card design. TR T
1. Select the card printer as the current printer.
2. Use the application’s page setup options to )

set the paper size to ISO-ID1. Set the margin
settings to 0.

3. Format the text and graphics to print on the
card.

Refer to the printer’s Installation and T

Administrator’s Guide for more information P ——
_— R e A BEEREN

on card design. -

4. Open the Card Printer Driver’s Printing
Preferences window.
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5. On the Layout tab, select Flip on Short Edge for [sseiae -
the Print on Both Sides setting. o I

6. Click Apply. rr—

o Your PC application’s Print settings may override the
settings in the Card Printer Driver. Make sure your

application’s Print settings specify “print on both =

sides”.

Printing a Card With Manual Duplex Printing
1. Putacardinthe input hopper or single-feed slot.

2. Click Print to send the card to the printer. The printer processes the first side
of the card.

3. After the printed card exits to the
output hopper, the LCD screen
displays Insert same card side 2 up
and the User and Card lights flash.

4. Pick the card up by the edges and
turn it over. Insert it under all cards
in the input hopper and push until it
drops into place.

5. The printer picks the card again and prints the second side.
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Disabling Card Side Printing for Special Card Designs

Some card designs require printing on only one side of the card. To avoid printing
on the wrong side or using ribbon for the side of the card with no printing, you

must set the Disable printing preference.

1. Open the Card Printer Printing e

Preferences window. Select the
Layout tab, click Advanced, and

click Disable Printing. (i e

2. Select the Disable Printing
option that prints the card
design correctly and save your

=

changes.

Disable

Printing

Option Off All Front Back

2-sided Print side 1 on front No printing | Printside 2 | Print side 1 on
and side 2 on back on back front

1-sided Print side 1 on front No printing | No printing | Print side 1 on

front

The entries in italics are unchanged by the setting. The other settings have the

potential to not print card data if they are used incorrectly.
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Setting Up to Print More Than One Copy of a Card

The Layout tab of Printing Preferences allows you to specify the number of copies
of the same card design to print. You can print from 1 to 255 copies of the same
card.

1.

7.

If you are using a card design application, set the number of copies in the
application. The application settings override the settings in Printing
Preferences.

Open the Printing Preferences window.
On the Layout tab, click Advanced.

Type the number of copies you want to print in the Copy Count field. You can
print from 1 to 255 copies of the same card design.

Click OK to close the Advanced Options page.

Click Apply to save your changes. Click OK to close the Printing Preferences
window.

Send the card(s) to print.

Rotating the Card

58

1.
2.

3.

Open Printing Preferences. Car——r— =i
On the Layout tab, click Advanced. M=

Select the side of the card you want to rotate
180 degrees, and select On.

As in the card shown, make sure to rotate the
back so that the text prints below the magnetic
stripe, not on top of it.

o If you are using a card design application, the application settings override the

settings in Printing Preferences. Make sure to verify your settings are correct.
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4. Click OK to save the setting, and then click
Apply on the Layout tab.

5. Send the card to print.

Setting the Print Area

The Card Printer Driver can prevent printing and applying a topcoat on specific
areas of the card. When cards include a magnetic stripe, a smart card chip,
signature panel, or other area that must remain unprinted or without topcoat,
define that area with a driver pre-set mask. These pre-set masks automatically
apply the dimensions and locations of smart card chips and magnetic stripes for
print blocking.

For more information on non-printing areas of a card, refer to the printer’s
Installation and Administrator’s Guide. For custom-defined areas, or to define
more than one blocking area per side of a card, refer to “Using Print Blocking
Escapes” on page 61.

To define pre-set masks for magnetic stripe or smart card areas, do the following:
1. Open the Printing Preferences window. e =]
2. Select the Print Area tab.

3. For the side of the card with the non-printing
area, select Print and topcoat entire side of
card except, and then select the area from the
list.

The example shown blocks printing on the

ISO 3-Track Magnetic Stripe areaonthe back |+~ . ... .in
of the card. Text shown on the back is e
formatted with a magnetic stripe font and is |

encoded.

4. Click Apply to save the setting, and then click
OK.

5. Send the card to print.
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The back of the completed card looks like this:

— = Notice the narrow white area above and below
— the magnetic stripe. The non-printing area is
' slightly larger than the feature, in this case the
magnetic stripe.

Printing Bar Codes Using Monochrome

60

The card printer can be set to detect bar codes embedded in an image and send
the image to print using the K (black) panel of color print ribbon. Refer to the
printer's Installation and Administrator's Guide for the type of bar codes the Card
Printer Driver detects, and for more information on printing bar codes.

Set the bar code detection using (s card Prstet AT i
the settings in the Advanced .
W XS Card Printer Advanced Document Settngs
Options window of Printing B Paper Output
Paper Spes L0 J0-1 (95,60 0 289 s
Preferences. Copy Count: 15op

H-iin Document Dpbors
=} 3y Prnter Features
Desable Printng: 0

1. Open the Printing Preferences

W| n d OW. Frint bar codes Lsng monodhrome: m
Rosate front sde card mage LB0 degrass: Off
. Rosate bad: sde card mmage 190 dagress: Cff
2. CI'Ck Advanced. Spkit Ribbon Fanels: Mo

3. Set the Print bar codes using
monochrome to On.

4. Click OK to close the
Advanced Options window.

5. Click Apply on the Printing
Preferences window.

Ok Cancel

6. Click OK to close the window.
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Using Escapes

Escapes are formatted text that the Card Printer Driver converts to support
features such as print blocking, topcoating, magnetic stripe data encoding, and
embossing.

HINTS & Tips

= For each escape, make sure that the text is consistent (same font, size, color).
Consider using a common font that is easy to see and differentiate from the
text you want to print on the card.

e Each escape must be on a single line with no formatting. Consider using a
small font size to make sure there is adequate room for long escapes.

« Do not align escape text to be on the same horizontal line as printed text.
Consider making each escape its own line of text on the card design.

Using Print Blocking Escapes

The Card Printer Driver provides two methods to prevent printing and topcoat on
specific areas of the card. Refer to “Non-Printing Areas” in your printer’s
Installation and Administrators Guide and “Setting the Print Area” on page 59
for more information.

By default, the entire surface of the card is available for printing and topcoating.
But when cards have a magnetic stripe, a smart card chip, or another non-
printable area such as a signature panel or hologram, you must define those areas
so that the printer will not print or apply topcoat to them.

To block other areas, or for more than one blocking area per side of a card, use
escape statements to define the print areas. Escape statements are specific
sequences of characters that mark data with a special purpose. The Card Printer
Driver recognizes the following types of escape statements:

= Block print
e Add topcoat

< Remove topcoat
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About Printing Areas

If the card has more than one non-printable area on a side, define both non-
printing areas using print blocking escapes. An escape statement applies to the
side of the card where it appears in the document.

Areas defined using print blocking escapes always override Card Printer Driver
Printer Preferences settings.

Each print blocking area is a square or rectangular shape.
Print Blocking Syntax

The syntax or structure of each print blocking escape statement is

~XX%n1n2n3n4? where:
e ~isthe beginning of the
statement ~XX%n1n2n3n4?
= XXrepresents the type of action — -|j T—End of statement
Block Print (PB), Add Topcoat (TA), Height of area
Width of area
or Remove Topcoat (TR) Distance from left
Distance from top
= % indicates the start of values Start of values
Type of action
e nlisthe distance from the top of — Beginning statement
the card to the start of the area
Left=0
e n2is the distance from the left - Width = 86.5 -
edge of the card to the start the Top = 1:mm fa
area Helght =16.8

e n3is with width of the area

< ndis the height of the area

e ?isthe end of the statement

The card in the example shows the dimensions of a three-track magnetic stripe
area.
Blocking typically extends 0.1 inch beyond the edges of a feature. The dimensions
listed include the extended blocking region.

The escape statement can specify more than one area of the same type by
placing a semicolon (;) character between the sets of values.
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Block Print Statement

A print blocking escape statement begins with “PB%

Examples:
~PB%10 10 55 157 Printing is blocked in one area, and any
print blocking set in Printer Preferences is not
used.

~PB%10 10 5 5;30.5 45.23 15 15? Printing is blocked in two areas, and any
print blocking set in Printer Preferences is not

used.

~PB%? No printing is blocked, and any print
blocking set in Printer Preferences is not
used.

Topcoat Add Statement

The topcoat add statement prints topcoat only in the area defined in the
statement. All other areas of the card do not have topcoat. All full-color printing
must be covered with topcoat. Use this option with care.

The topcoat add statement begins with ~“TA%

Examples:

~TA%0 0 86.5 377 Topcoat is applied to one large area of
the card and any topcoat setting in
Printer Preferences is not used.

~TA%16.8 0 37.1 5;30.5 45.23 15 15? | Topcoat is applied in two areas and any
topcoat setting in Printer Preferences is
not used.

Topcoat Remove Statement

With a topcoat remove escape, the topcoat is omitted in the areas defined by the
escape. All other areas of the card have topcoat.

The topcoat remove statement begins with ~“TR%
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Full-Card Topcoat Options

e Use the string “TR%? to override the Card Printer Driver preset masks and
topcoat the entire card side.

e Use the string ~“TA%? to override the Card Printer Driver preset masks and
apply no topcoat to the entire card side.

HINTS & Tips

Print several cards using your card design and application to verify that printing
and topcoat are applied as you intend.

Using Magnetic Stripe Escape Codes

The data to encode on a magnetic stripe is entered as text and can look like data
to print. The Card Printer Driver uses magnetic stripe escape codes to identify the
data to encode. Data contained in escape codes is not printed. The Card Printer
Driver supports several escape code systems to allow easy compatibility with
other card printers. Refer to “Supported Escape Codes” on page 65 for more
information.

Setting Up Magnetic Stripe Escape Codes
1. Use card production software or another application to create a card design.
2. Format the text and graphics to print on the card.

3. Type the encode data (text) for one track. Locate an area on the card where
typing the data to encode does not affect other card design components.

The example shown uses the

~<track#><Start Sentinel><Data> <End B ko' Tt Pwat Tl Talhn™ Merke -t
Sentinel> syntax. A Towsliowioan « % « B 7 O EE T E &

SRS

Zachary Hamilton

The text for track 1 looks like this:
~1%Zachary Hamilton 12345 Finance?

< Do not put data for two tracks on the
same line.

D 12345

Fz.l‘ I.t.'v'll1‘|.‘-_":.'| 12345 Foanee
=S AR
« Do not allow the text to encode to D T TR0 26 AR 438 TN L4 F

wrap to another line. Use a smaller o

font size to keep the text on one line.
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= If necessary, you can use two or more lines of text for one track. Start and
end each line with escape codes; enter a carriage return at the end of the
line. The Card Printer Driver adds (appends) lines for the same track
together.

= Data to encode can be on side 1 (front) or side 2 (back) of the card.

= Do not enter data to print on the same line as data to encode. It will not
print.

Press ENTER to end a line.

Repeat Steps 3 and 4 for each track of magnetic stripe data.

oo o &

With magnetic stripe cards in the printer, send the card to print.

7. Verify that the encoding was successful by passing the card through a card
reader.

Supported Escape Codes

The escape code defines the track for the data. Because the data format for each
track is set in the printer, you must enter the type of data the format requires. The
table below shows the default ISO format data, and how the data looks when
formatted. The syntax column shows the general statement for how the data
must be provided. For each track there is an example of how the data looks.

Syntax Track Example Manufacturer

~<track#><data> 1 (IATA) | ~1ENCODING WITH ESCAPES Eltron/Zebra

2 (ABA) | ~21234567890

3(TTS) | ~31234567890

~<track#>=<data> 1 (IATA) | ~1=ENCODING WITH ESCAPES Atlantek

2 (ABA) | ~2=1234567890

3 (TTS) ~3=1234567890
~<track#> 1 (IATA) | ~1%ENCODING WITH ESCAPES? Datacard HiFX, RP90X,
<Start Sentinel> and SRxxx; JVC; and
<data> <End Sentinel> | 2 (ABA) | ~2;12345678907? Fargo
The only Start Sentinel
3 (TTS) ~3,;12345678907? permitted for tracks 2

and 3 is a semicolon (;)
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HINTS & TIPS

Use a small font size to shorten lines of text to encode.
Keep text to print on a different line than text to encode.

When the Card Printer Driver adds lines of text for the same track, the
sequence is determined by the application. Test your application with the
Card Printer Driver to make sure the data is in the correct order.

Magnetic stripe data sent by the Card Printer Driver is always encoded on
side 2 of the card.

Magnetic stripe data is converted to uppercase letters if needed.

If characters unsupported by a track format are sent within the magnetic
stripe data, the printer displays a message.

Using Embosser Escapes

An embosser escape is made up of the following elements:

Escape preamble—tells the Card Printer Driver the text characters following
are part of an embosser escape and not text for rendering on the card.

Embosser font number—CE Series systems use a font number to specify the
emboss or indent character set, the front or back of the card, and in some
cases the supply to use.

Emboss/Indent position—two values specify the starting location of the
emboss/indent operation.

Emboss data—the text to be embossed or indented at a given location using
the font number specified

Embosser Escape Syntax

The embosser escape syntax is: YEM% font#; horz_offset; vert_offset; data

Use a semicolon (;) character to separate embosser escape elements.

Escape Preamble
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In the preamble, the characters YEM% identify the beginning of an emboss
escape.
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Embosser Font Number

The usable font numbers are based on the emboss wheel installed in CE Series
systems. Several fonts from the following list typically are supported by a given

wheel:
1= Emboss Standard Gothic [front 10 cpi]
2= Emboss Farrington 7B [front 7 cpi]
3= Indent OCRB [back 10 cpi]
4= Indent Master Card Slanted [back 14 cpi]
5= Indent OCRB Size IV [front 7 cpi]
6= Indent Master Card Slanted [front 14 cpi]
7= Indent OCRB Front [front 10 cpi]
8= Indent Master Card Inverted [back 7 cpi]
9= Indent Helvetica [front 14 cpi white ribbon]*
10= | Indent Helvetica [front 14 cpi black ribbon]*

* Note: Add 20 decimals to override default side.

Emboss/Indent Position

The position of the start of the emboss or indent data.

horz_offset Whole number in mils (1/1000 of an inch) from left
edge of card to center of first character

vert_offset Whole number in mils (1/1000 of an inch) from bottom
edge of card to the vertical midpoint of the
characters

There are restrictions on the horizontal and vertical offsets.

Horizontal Offset Limits

Topping Maximum Value Minimum Value
on 3025 280
off 3275 100
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Vertical Offset Limits

Topping Maximum Value Minimum Value
on 860 135
off 1460 135

Emboss Data

CE Series systems have restrictions for the characters allowed.

The emboss data range is from 20 hex to FF hex.

Reserved XML characters (3c hex and 3e hex) are not allowed as emboss
characters.

For data greater than 127 ASCII, an escape code must be used (e.g., &#181; is
used to emboss a Katakana character [B5 hex]).

Using Magnetic Stripe Fonts

The Card Printer Driver provides fonts to format magnetic stripe data. Use these
fonts when magnetic stripe escapes cannot be used.

1.

68

Use the application’s page setup feature [ 4 23
to set the paper size to ISO ID-1. Reduce | — = =7 "o e
the page margins to match the card e e E it

IR T - B T X AR = |

design.
Format the text and graphics to print on : ; ]
the card. ; “Allied

[ Zachary Hamilton

Type the data to encode using a standard
font, such as Arial.

e Use a small font size to minimize the
amount of space used for encoded
data.
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= Do not put data for two tracks on the |

ta T 938
same line.. | e | o W s
-"_I -'. feri RrmBemas =110+ 0AD gt el Al S -
= Do not allow text to encode to wrap "“w, S e e
to another line. @ : 3

« Data to encode can be on side 1
(front) or side 2 (back) of the card.

Zachary Hamilton
[ R ritl]

4. Add an extra space character to the end
of the data. sicacin
5. Select a line of data up to the extra space F._-E.).J_Z.—J .
character and apply one of the following | — " =& "= == e 0
fonts: i —__OOL ol
. h:_. .| Cambeis trmaten [ | =
e Mag Track 1 XPS Card Printer O . o
- * Mag Track 1 XPS Cand Plint:' |
= Mag Track 2 XPS Card Printer % Mod Teack 3 %PS Card Printe
% Anal
e Mag Track 3 XPS Card Printer ¥ Lucidar Handwricing: &
% Lucida Brght
e Mag Track JIS XPS Card Printer e
6. Repeat Steps 3 -5 for each line of text to
encode.
7. Send the card to print.
8. Verify that the encoding was successful by passing the card through a card
reader.
HINTS & TiPs

Do not use character formatting, such as kerning.

Do not use smart quotes.

Use a small font size to shorten lines of text to encode.
Keep text to print on a different line from text to encode.

When the Card Printer Driver adds lines of text for the same track, the
sequence is determined by the application. Test your application with the
Card Printer Driver to make sure the data is in the correct order.

Magnetic stripe data sent by the Card Printer Driver is always encoded on
side 2 of the card.
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= Magnetic stripe data is converted to uppercase letters if needed.

= If characters unsupported by a track format are sent within the magnetic
stripe data, the printer displays a message.

If you have an existing application that uses magnetic stripe fonts from older
generation printers, the Card Printer Driver will recognize these fonts. If they are
not installed, use the “Legacy Support” option on the driver installation Support
Files screen to install them.
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Chapter 5: Installation
Troubleshooting

This section describes:
e Troubleshooting the Card Printer Driver Installation

e Using Advanced Troubleshooting Tools on page 74

The Card Printer Driver Installation CD is provided in the CD Folder included in the
shipping carton. If the CD is not available, you can download the driver from
http://www.datacard.com. Select Support & Drivers > Drivers & Download from
the menu. Enter your printer model in the Enter Product Name or Number area,
and click Go.

Troubleshooting the Card Printer Driver
Installation

This section describes issues that could prevent a successful installation and
provides recommended solutions to those issues. Choose from the following
topics:

« USB Installation Troubleshooting on page 72

< Network Installation Troubleshooting on page 74
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USB Installation Troubleshooting

72

Problem

Solution

The cable is loose.

Reconnect the USB cable to the ports on the PC and
the printer. Power the printer OFF, and then back ON.
If the PC and printer still do not communicate, restart
the PC.

The data cable is
damaged or frayed.

Power off the printer. Replace the cable if you have
a spare. Contact your service provider to order a
new data cable.

The system has a
temporary
communication
problem.

Check the following:

- USB extension cables can cause
communication problems. The recommended
USB cable is 6-ft. (2 meters) long. Make sure that
the cable is rated for USB 2.0 data transmission.

- If you are using a USB hub, a self-powered hub
is recommended.

The card printer does
not install when the USB
cable is connected.

If the printer is not recognized by the PC, or if a
previous printer installation was interrupted, Device
Manager might still show an entry for the printer.
Remove the printer entry from Device Manager
before re-installing the printer.

1. Disconnect the printer from the PC.

2. If the printer was previously installed, make sure

that it is deleted.

3. Open the Windows Device Manager.

4. Locate the device to delete. The device might
be called “Unknown device” or it might be
located under the Printers or Network Adapters
folder. The device might be marked with a
yellow question mark or exclamation point.

5. Select a device name, and right-click to display
a pop-up menu.

6. Select Remove from the pop-up menu.

7. Click Yes or OK to confirm removal of the
device.

8. Close the Device Manager. Close any other
windows.

9. Re-install the printer.

Error message states
the USB not detected.

The USB installer timed out before a printer was
detected.

Remove the Card Printer Driver from the Device
Manager before re-installing the printer.

Installation Troubleshooting



Problem

Solution

The USB cable is
connected before the
Card Printer Driver is
installed.

The first printer installed on a PC using a USB
connection must be installed from the driver CD or
downloaded Card Printer Driver.

Connect the USB cable to the printer when

prompted; do not connect it before starting the
installation.

The Print Sample Card
button is inactive.

The Print Sample Card button in Printer Properties is
enabled when the printer and Card Printer Driver
communicate normally. If Print Sample Card is
inactive (gray), make sure that the User button on
the printer front panel is steady green and that Ready
displays on the LCD panel.

The Print Sample Card button is not available when
printer pooling is enabled.

The PC USB port does
not communicate with
the printer USB port.

Power management on the PC has shut down USB
communication.

Open the Device Manager and the list of USB
devices. Disable shutdown for each hub in the list.
You might need to restart the PC for the changes to
take effect.

Hibernation on a laptop PC requires several moments
to enable USB communication. Unplug the USB
printer port and then connect it again.

Replace the PC port or the PC. Contact your PC or
port vendor if you need assistance.

The printer does not
install or print on the PC
when the PC is
connected to a
remote network using
VPN Client software.

VPN Client software can prevent the installation and
use of other devices. Choose one of the following
solutions:

= Configure your VPN software to allow local
network connections.
e Disconnect the VPN Client software from the

network, and then install the USB printer and
Caurd Printer Driver, or resume printing.

XPS Card Printer Driver Guide
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Problem

Network Installation Troubleshooting

Solution

The network cable is
loose.

Reconnect the data cable to the network port and
the printer, making sure that it is snapped in. Restart
the printer.

The Status page of
Printer Properties shows
the printer is not
available, but the
printer shows “Ready”
on the LCD screen.

Follow your network troubleshooting procedures to
isolate and test each component of the computer-
to-printer communication link.

Suggestions:

e Check the computer-to-network connection by
accessing a network resource, such as a
network drive.

e Have the network administrator check
communication between a server and the
printer.

= Make sure that the user is logged in to the
network.

The printer is not
configured with the
correct network
address.

Make sure that the server name or IP address has
been entered in the Port Settings or Configure Port
dialog box on the computer. For information on
retrieving the printer’s IP address, refer to the card
printer’s User’s Guide.

Make sure that Ready displays on the printer's LCD
panel.

Using Advanced Troubleshooting Tools

For additional troubleshooting topics, refer to the printer’s User’s Guide.

The Printer Manager also provides access to additional troubleshooting tools.
Refer to the your printer’s Installation and Administrator’s Guide for information
about using the Printer Manager.

Installation Troubleshooting



Appendix A: Windows 7 and
Windows 8 Printer Sharing

This appendix provides information about installing
and sharing the Card Printer Driver on a PC running
the Windows 7 or Windows 8 64-bit operating
system.

Windows 7 or Windows 8 Installation

Printer sharing involves setting up the host PC for sharing, then installing and
setting up the Card Printer Driver on each client system that will print to the
printer.

Setting Up the Host PC for Printer Sharing

1. Install the XPS Card Printer Driver on the host PC. Refer to “Installing the
Driver” on page 8.

2. Configure the host PC for printer sharing.

A. From the Windows Control Panel, select Network and Internet > Network
and Sharing Center.

B. Select Change advanced sharing settings from the left column. The
Advanced sharing settings window or the Network profile options display. If
the Advanced sharing settings list displays, select the network profile you
want to work with.

o The Advanced sharing settings display varies depending on a system’s setup. In
addition, based on its setup, a system may open one of the profiles and display the
options shown in step C.

C. On the Network profile options page, select the following options (these
are the default settings).

Eield Select option

Network discovery Turn on network discovery

File and printer sharing Turn on file and printer sharing
Password protected Turn on password protected sharing
sharing
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D. If you selected (turned on) any options in this step, click Save changes.
Close the Network and Sharing Center window.

3. Enable printer sharing.

A. Open the Devices and Printers window and right-click the card printer icon.
Select Printer properties to display the Printer Properties window.

B. Allow printer sharing.

i.  On the Printer Properties window, select the Sharing tab.

ii. Select Share this printer. The printer name displays in the Share name
field. Write down the printer name.

Remember to record the printer name and host PC name. You need these
names to install the Card Printer Driver on the client PC. For more about
printer names, refer to “Use device naming rules for shared printers”

on page 25.

ii. Select Render print
jobs on client
computers.

iv. Click Apply to store
these settings.

Gerwral, 879 Pots | Advanced | Cokor Mansgement | Securty | Prrer Status | Card Counts | Sepobes | About

;W you share this pinter, only users on pour network with 1 usemame
SEL  and prrsword fee this computer can pontbe it The printer will met
Er avadable whm fr sompadn dborgi 16 change theie ietings
it the Metmork sad Shat .

| Bencler et jobt o client comprtan

Drivers
¥ thig prited it thared math uiet nersisg difenent werisnt of
Wirsdorws, pou may wind o instal sdditional driver, 4o thinl the
users tomot harwe: bo find the print dever when they conned to the
thared premer
Aghitronal Demveri..
oK Carcd Bocky

Keep the Printer Properties window open while you find the full computer name in

step C below.

C. Find the host PC full computer name and write it down.

i. From the Windows Control Panel, select System and Security >

System.

ii. Write down the name of the computer found in the Full computer
name field on the System window.
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Close the System window.

4. Configure security for sharing printing and viewing print error messages.

A. From the Printer Properties window, select the Security tab.

B. Review the Group or
user names list. Make
sure that the default .
settings on the Security h
tab have the following

printer-sharing
permissions:

= KL Card Printer Properties =

(Garernl | Shanng | Pots | Advanced | Cokor Mansgement | 2460ty | Prroer Status | Card Counts | Supobes | About

L Tiester § [HFTG_§ Tnther )
S Aderestaton (4P 30 _E' Admrstalon

Everyone has Print . . @,_
permission set to @
Lanags uk pler

Allow (refer to the Mo s

figure at right). s

Only CREATOR For mpbal plemitbons of Bdhvandad plingt. chek Advanced Adgriced
OWNER has

Manage :
documents el i

permission set to
Allow. This lets the owner both view printer error messages and
perform document-related administrator tasks at the PC.

C. If you made any changes, click Apply to save your updates.

D. Add users or groups.

Vi.

From the Security tab, click Add. The Select Users or Groups dialog box
displays.

Click Advanced and then Object Types.

Select the check boxes for Users and Groups and click OK. The Select
Users or Groups dialog box displays.

Click Find Now. A list of user and group names displays.

Select each name to add and click OK. The name(s) you selected
display in the Select Users or Groups dialog box.

When you finish adding names, click OK. The names display on the
Security tab; each name has Print permission.

XPS Card Printer Driver Guide A-3



A-4

E.

vii. If you want to revoke Print permission and prevent a user or group
from printing, select the user or group and clear the Allow check box
for the Print permission.

Do not select the Manage documents or the Deny check boxes for any user
or group. Only the CREATOR OWNER should have Manage documents
permission set to Allow, which is the default.

Allow users or groups to view printing error messages.

i. From the Security tab, select a user or group and select Allow for the
Manage this printer permission.

ii. Repeat for each user or group.

iii. Click Apply to save changes for each name.

5. Set up Windows printing for card design.

A.

From the Devices and Printers window, right-click the card printer icon and
select Printing preferences. The Printing Preferences window displays.

Enter your printing preferences. For instructions, refer to “Configuring PC
Printing Preferences” on page 47.

Write down the printing preferences settings for ribbon type and print
resolution.

These settings are not set automatically at the client PC to match the host. You
must enter these settings manually on each client PC when you set up printing
preferences. For instructions, refer to “Configuring PC Printing Preferences”
on page 47.

Click OK to close the Printing Preferences window.
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Installing the Card Printer Driver on the Client PC

The following instructions may vary slightly based on the operating system of the
client PC. See “Printer Sharing Requirements” on page 22 for a list of supported
host/client operating system combinations.

1. Make sure that the Card Printer Driver is installed and set up on the host PC.

2. Login to the client PC with a user account that has administrator privileges
and matches an account and password on the host PC.

= Start at the Login screen of the client PC and review the user names
displayed. Look for a user with administrator access that matches a user
name on the host PC. If one is not listed, set up a user account and
password on the client PC to match an administrator account from the
host PC.

OR

e Login to the host PC from the client PC using a network access as follows:
e Use Windows File Explorer or My Computer to locate the host PC.
e Select the host PC. The Enter Network Password dialog box displays.

« Enter your password and click OK. The host PC desktop displays.

You must log in to the host PC across the network by using a different user
account than was used to install the printer on the host.

After logging in to the host PC using the network, keep the window open
until the installation completes.

3. Add the Printer to the client PC.

A. Open the Windows Devices and Printers window.
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B. Select Add a printer.
The Add Printer window
displays.

C. Windows 7: Select Add
a network, wireless, or
Bluetooth printer.

The system displays a
list of available
printers.

D. If the printer does not
display in the list:

i. Select The printer
that | want isn’t
listed. The Find a
printer... page
displays.

U = Add Printer

What type of printer do you want to install?

% Add a local printer

Use this option anly if you don't have a USB printer. (Windows automatically installs USB printers
when you plug them in.)

# Add a network, wireless or Bluetoath printer

ake sure that your computer is connected to th orthat your Bluetooth or wireless

i. Inthe Select a shared printer by name field, enter the name of the
host PC and the shared printer name following this format:

\\host PC name\shared printer name

o Use the names you wrote down during the host PC installation in step 3.B.

jii. Skip to step E.

iv. If you don’t have the printer name, enter the host PC name. Use the

format:

\\host PC name\

A-6
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When you type the last
backslash without a

. L3 = dashon
printer name, a drop-
down list displays host
printers. [ ot for s prves
v. Select the name of the vl _ [

card printer for sharing.

E. Click Next. If the Do you trust
this printer? dialog box
displays, click Install Driver.

Windows installs the Card

Printer Driver. The message | liet | | e
“You’ve successfully added
printer name” displays when the installation is complete.

F. Click Next. The “To check your printer...” message displays.
G. Click Finish to close the Add Printer page.

4. If card production software is installed on this computer, or if you need other
support files, such as magnetic stripe fonts, install the XPS Card Printer Plug-in
or support files from the driver CD. For instructions, refer to “Installing the
Support Files from the Driver CD” on page 15.

5. Set up Windows printing for card design.

A. Get the Printing preferences settings you wrote down at the host PC for
ribbon type and print resolution.

These settings are not set automatically at the client PC to match the host,
so you must enter them manually.

B. From the Devices and Printers window, right-click the card printer icon and
select Printing preferences. The Printing Preferences window displays.

C. Enter the required printing preferences. For instructions, refer to
“Configuring PC Printing Preferences” on page 47.

D. Click OK to close the Printing Preferences window.
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Appendix B: Windows XP

Printer Sharing

This appendix provides information about installing
and sharing the Card Printer Driver on a PC running
the Windows XP, 32-bit operating system.

Windows XP, 32-bit Installation

Printer sharing involves setting up the host PC for sharing, then installing and
setting up the Card Printer Driver on each client system that will print to the

printer.

Setting Up the Host PC for Printer Sharing

1.

Install the Card Printer Driver on the host PC. Refer to “Installing the Driver”
on page 8.

Clear simple file sharing on the host PC.

A.

D. Inthe Advanced settings list, scroll

From the Windows Start menu, click

My Computer. If needed, click

Explore. The My Computer window

displays.

Click Tools and select Folder
Options.

Select the View tab

to Use simple file sharing
(Recommended) and clear the
selection.

[ Folder Gptians B3]

Genaral View | Fils Types | Oifire Filss

g ou con apply the view fsuch o Detais or Tiex] ihat
ﬂ youd ate urg for this folder b o foldess

ApphytoARFoiders | [ Bmsst Al Fokiers |

Advanced telings:
[ Lawnch folder windoves in 4 sepanate process ~
=) Managng pars of Web pages and foldeis
(5} Shiow and manage the par at & smge fle
12} Shiow both paets and manage tham indeiduall
1) Show both pads bud manage sz a single e
[¥] Remember each lolder's iew setings
[} Restons previous hoder windiows: at logon
] Show Contral Panel in My Computer
[ Show encrypled of compiessed NTFS Hes i coke |
[ Show popup deacription for fokder and daskiop bems
=) [Use simgde fie shiving [lecommended]|

i
ﬂe:nm];:sau:
[ ok [ canca [ seow |

Make sure to clear (turn off) simple file sharing while setting up the host PC for file
sharing. Simple file sharing causes certain features, such as the Security tab, to be
hidden. You must be able to display the Security tab to configure security later. You
turn on simple file sharing again after setup is complete.

E. Click OK to save your changes and close the Folder Options window.

F. Close the My Computer window.
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3. Open the Printers and Faxes window.
4. Write down the printer name and the host PC name.

A. From the Printers and Faxes window, write down the name of the newly
installed card printer.

o Remember to write down the printer name and the host PC name (see below). You
need these names to install the Card Printer Driver on the client PC. For more about
printer names, refer to “Use device naming rules for shared printers” on page 25.

B. Find the host PC name.
i. Openthe Windows Control Panel.
i. Double-click System and select the Computer Name tab.

ii. Write down the name shown in the Full Computer Name field. You
must enter this as the host PC name when you install the printer at the
client PC.

iv. Click OK to close the System window.

5. On the Printers and Faxes window, right-click the card printer and select
Properties to open the Printer Properties window.

6. Enable printer sharing.
A. Select the Sharing tab on the Printer Properties window.

Depending on your network configuration, the Sharing tab may display
with a statement that remote access is disabled.

ieewal SPawy Fors | Ascarost | Dol Miragee—d | Fantm S | Caed County | Supplien | Sbeut

| 3% Cowd Prvrmm
=

Bd By B stk b R s 1 T
ot Fomrvm, pou Can sratie weche o e stk thae
mwmn b warweng e Bisbet {stup ead

DL prir mnl o ooty el e by e

| iy e
EATEG M e ] Chol Fe

i. Select If you understand the risks but want to share printers without
running the wizard, click here.
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ii. When the Enable Printer Sharing dialog box displays, select Just enable
Printer Sharing, and click OK.

W pcni i g o B Cormfube vatfuad L] e Ntk
Tewbup Winard, the compuber coukd be vuirevebie 1o sflisck s hom
i e e OOy MO Bl (e s e Feabeh
Shgh Wik i) prokec] v Eofgiden

e P svamid] b erualils peried dhare [Foec omamescied]
= phod erabie prrie unng

— ot [ Cwem |

B. Click Share this printer to enable sharing. Write down the printer name
that displays in the Share name field. Refer to the figure below.

& XP5 Card Printer Propesties

Gienwsai| Sharg | Py | Advanced | Coks Management | Prrier Sl | Card Cowrty | Suppies | kol

'Wiew i s e powlinl wath bty Lt o s ek, T
enatde g ko B v, cheh Shass B gonle Windows
Firvsall i sy corfguen iz alow Bye hanng of perivrs wih
e compuiss) on B ek

(7 Cha ot it i prrites
() Ghae Bae prinkes

Ghais ramekc PG Cand Pty
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‘wirakwrt, o iy want o rtal scdtonal dres 50 thal e
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C. Click Apply to apply the printer sharing settings.
7. Configure security.
o Skip this Configure security section if you want to accept the following defaults:
= All users (the Everyone account) can print, and

e Only the person who enabled sharing on the printer (the
CREATOR OWNER account) can view printer error messages at the
client PC.

Users at the client PC can view printer error messages from the Windows
Print Manager. These printer errors can be resolved at the printer LCD screen or
host PC.

For more information, refer to “Security permissions for shared printers” on page
24, and “Setup to view Message boxes” on page 24.
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A. Select the Security tab on the Printer Properties window.

B. Review the Group or user names list. If the names or group for which you
want to specify permissions do not appear in the list, add the names or
create a group:

i. Click Add to display the Users and Groups dialog box.

ii. Selectthe name you want to add, and click Add. Repeat for each name
you want to add.

ii. When you are finished adding names, click OK to close the Users and
Groups dialog box.

C. Assign print permissions.

i. From the Group or user names list on the Security tab, select the name
or group to be assigned permissions.

o Do not select the Manage documents or the Deny check boxes for any user
or group. Select Allow for Manage Printer if you want a user or group to
view message boxes.

ii. Select Allow for permissions you want to apply to the user or group.

iii. Clear the Allow check box for permissions you want to deny the user
or group.

iv. Click Apply to save your changes. Make sure to save changes for each
user or group.

8. Enable bidirectional support.
A. Select the Ports tab on the Printer Properties window.
B. Confirm that Enable bidirectional support is selected.
C. Click OK to close the Printer Properties window.

9. Set up Windows printing for card design.

A. From the Printers and Faxes window, right-click the card printer icon and
select Printing preferences. The Printing Preferences window displays.

B. Enteryour printing preferences. For instructions, refer to “Configuring PC
Printing Preferences” on page 47.
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C. Write down the printing preferences settings for ribbon type and print
resolution.

o These settings are not set automatically at the client PC. You must enter these
settings manually on the client PC when you set up printing preferences. For
instructions, refer to “Configuring PC Printing Preferences” on page 47.

D. Click OK to close the Printing Preferences window.
10. Turn on Simple File Sharing and Restart.

A. Open the My Computer window.

B. Click Tools and select Folder Options.

C. Select the View tab.

D. Inthe Advanced settings list, select Use simple file sharing
(Recommended).

E. Click OK to save the change and close the Folder Options window.

Make sure to select (turn on) simple file sharing at this point in the installation.
Simple file sharing causes certain features, such as the Security tab, to be
hidden, allowing you to protect the permissions you set up.

F. Close the My Computer window.

G. You must restart your computer to apply simple file sharing. From the
Windows Start menu, select Restart.
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Installing the Driver on the Client PC

B-6

For Windows XP only: Before the installation, you must install the “Windows XP
driver support” files (Service Pack 3). For more information, refer to “Installing the
Support Files from the Driver CD” on page 15.

Make sure that the Card Printer Driver is installed and set up on the host PC.

Log in to the client PC with an account that has administrator privileges and
matches an account on the host PC.

The client PC must have a user account and password that matches an
account on the host PC.

Add the printer.

A.

B.

From the Windows Start menu, select Printers and Faxes.

Select Add printer.

| ndd Printar Wizard

Click Next on the Add e which e of e 13 16
Printer Wizard window.

Selek the option that dadcibas e Barbar pod vt 16 uia
Select A network ST AT
printer, or a printer ey Ty p—r
attached to another
computer and click
v Tip sef up o resteork, pender thet is rot etteched o & pind perver,

Next. ._.li‘J e tha Lo ol pembat” pphiom

On the Specify a Printer
page of the wizard,
select Connect to this
printer.

l & Btk :[ Mt 3 |[ Cancel

Enter the name of the host PC and the device printer name by doing one
of the following:

« Use the names you wrote down during the host PC installation using
the format:

\\host PC name\shared printer name
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« [If you don’t have the printer name, enter the host PC name using the
format:

\\host PC name\
When you type the last backslash without the printer name, a drop-
down list displays host printers.
Select the shared printer from the drop-down list.
G. Click Next. The Connect to Printer dialog box displays.

H. Click Yes to continue. The Default Printer page displays set to Yes and the
shared card printer icon displays on the Printers and Faxes window.

I.  Click Next to display the Completing the Add Printer Wizard page.
J. Click Finish to close the wizard.

4. |If card production software is installed on this computer, or if you need other
support files, such as magnetic stripe fonts, install the XPS Card Printer Plug-in
or support files from the driver CD. For instructions, refer to “Installing the
Support Files from the Driver CD” on page 15.

5. Set up Windows printing for card design.

A. Get the Printing preferences settings you wrote down at the host PC for
ribbon type and print resolution.

These settings are not set automatically to match the host PC, so you must
enter them manually.

B. From the Printers and Faxes window, right-click the card printer icon and
select Printing preferences.

C. On the Printing Preferences window, enter the required printing
preferences. For instructions, refer to “If the Windows Print Manager is
already open, press F5 to update the current print job status in the
Print Manager window.” on page 26.

D. Click OK to close the Printing Preferences window.
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Appendix C: Windows Server
2003 Printer Sharing

This appendix provides information about installing
and sharing the Card Printer Driver on a PC running
the Windows Server 2003, 32-bit operating system.

Windows Server 2003, 32-bit Installation

Printer sharing involves setting up the host PC for sharing, then installing and
setting up the Card Printer Driver on each client system that will print to the
printer.

Setting Up the Host PC for Printer Sharing

1. Install the XPS Card Printer Driver on the host PC. Refer to “Installing the
Driver” on page 8.

2. From the Windows Start menu, select Printers and Faxes. The Printers window
displays.

3. Write down the printer name and the host PC name.

o You need the printer name and host PC name for installing the Card Printer Driver
on the client PC. Record them and have them available when the client PC is
installed. For more about printer names, refer to “Use device naming rules for
shared printers” on page 25.

A. In the Printers window, find the name of the newly installed card printer
and write it down.

B. Find the host PC name and write it down.

i. From the Windows Start menu, right-click My Computer and select
Properties.

ii. Click Computer Name. The host PC name displays in the Full Computer
Name field.

iii. Write down the name of the host PC.

iv. Click OK to close the System properties window.
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4. Enable printer sharing.

A. In the Printers window, right-click the card printer icon and select Sharing.
The Printer Properties window displays the Sharing tab.

B. Click Share this printer to enable sharing. The printer name displays in the
Share name field. Make sure that a printer name displays.

o The printer Share name is assigned by the Windows operating system. This displays
as the same printer name (or an abbreviated version of the printer name) you wrote

down earlier.

C. Click Apply to save the settings. The “hand” symbol (for “shared device”)
shows under the card printer icon in the Printers window.

D. Click OK to close the Printer Properties window.

Installing the Card Printer Driver on the Client PC

The client PC may use any of the supported Windows operating systems. Refer to
“Printer Sharing Requirements” on page 22 for a list of supported host/client
operating system combinations. Except as noted, these steps apply to all client
Windows systems. The instructions may vary slightly based on the operating

system of the client PC.

1. Make sure that the Card Printer Driver is installed and set up on the host PC.

2. Login to the client PC with a user account that has administrator privileges
and matches an account and password on the host PC.

o Before you log in, review the log in screen. Look for a user account that matches an
account on the host PC. If not listed, set up the user account and password on the

client PC.

3. Add the printer.

A. Display the appropriate Printers window, as follows:

Operating System

Action:

Windows XP

Select Printers and Faxes. The Printer and
Faxes window displays.

Windows 7,
Windows 8

Select Devices and Printers. The Devices
and Printers window displays.

B. Select Add a printer from the Printers window. The Add Printer wizard

displays.
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C. If needed, click Next on the Add Printer wizard.

The Local or network printer page displays.

D. Add a network printer.:

Operating System

Action:

Windows XP

Select A network printer, or a printer
attached to another computer.

Windows 7

Select Add a network, wireless or
Bluetooth printer. The Searching for
available printers... page displays.

E. Connect to the shared printer:

Operating System

Action:

Windows XP

Click Next. The Specify a Printer page
displays.
Select Connect to this printer.

Windows 7
Windows 8

If the card printer does not display, click
The printer that | want isn’t listed. The
Find a printer... page displays with the
option Select a shared printer by name
automatically selected.

F. Enter the name of the host PC and the shared printer name by doing one

of the following:

e Use the names you wrote down during the host PC installation using

the format:

\\host PC name\shared printer name

« If you don’t have the printer name, enter the host PC name using the

format:

\\host PC name\

When you type the last backslash without the printer name, a drop-
down list displays host printers.

Select the shared printer from the drop-down list.
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4.

G. Click Next. A message displays stating you are about to connect to the
printer. Another message may display stating “To use the shared
printer...you need to install the printer driver.”

H. Install the Card Printer Driver:

Operating System Action:

windows XP Click Yes to continue.

The Default Printer page displays set to Yes
and the shared card printer icon displays
in the Printers and Faxes window.

Click Next.

Windows 7 Click Install Driver. When a message
states that you’ve successfully added the
printer, click Next.

A message notifies you that you successfully added the printer.
|.  Close any open windows.
J. Click Finish to end the wizard.

If card production software is installed on this computer, or if you need other
support files, such as magnetic stripe fonts, install the XPS Card Printer Plug-in
or support files from the driver CD. For instructions, refer to “Installing the
Support Files from the Driver CD” on page 15.

Set up Windows printing for card design.

A. Get the printing preferences settings you wrote down at the host PC for
ribbon type and print resolution.

These settings are not set automatically at the client PC to match the host,
so you must enter them manually.

B. From the Printers window, right-click the card printer icon.
C. Select Printing Preferences. The Printing Preferences window displays.

D. Enter the printing preferences. For instructions, refer to “Configuring PC
Printing Preferences” on page 47.

E. Click OK to close the Printing Preferences window.
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Appendix D: Windows Server
2008 Printer Sharing

This appendix provides information about installing
and sharing the Card Printer Driver on a PC running
the Windows Server 2008, 64-bit operating system.

Windows Server 2008, 64-bit Installation

Printer sharing involves setting up the host PC for sharing, then installing and
setting up the Card Printer Driver on each client system that will print to the

printer.

Setting Up the Host PC for Printer Sharing

1. Install the XPS Card Printer Driver on the host PC. Refer to “Installing the
Driver” on page 8.

2. Configure the host PC for printer sharing.

A. From the Windows Control Panel, select Network and Internet >
Network and Sharing Center.

B. Select Change advanced sharing settings from the left column. The
Advanced sharing settings window or the Network profile options display. If
the Advanced sharing settings list displays, select the network profile you
want to work with.

The Advanced sharing settings display varies depending on a system’s setup.
In addition, based on its setup, the system may open one of the profiles and
display the options shown in step C.

C. On the network profile options page, select the following options:

Field Select option

Network discovery Turn on network discovery

File and printer sharing Turn on file and printer sharing
Password protected Turn on password protected sharing
sharing

XPS Card Printer Driver Guide
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D. Click Save changes. The Advanced sharing setting window closes.

3. Write down the printer name and host PC name.

Remember to record the printer device name. You need this printer name to install
the Card Printer Driver on the client PC.

A. Select the General tab on the Printer Properties window to display the
printer device name.

B. Write down the name of the printer.

C. From the Windows Start menu, display the System properties window for
your computer.

D. Write down the host PC name found in the Full Computer Name field.
E. Close the System properties window.

4. Display the Devices and Printers window. Right-click the card printer icon and
select Printer properties. The Printer Properties window displays.

5. Enable printer sharing.
A. Select the Sharing tab on the Printer Properties window.
B. Click Change Sharing Options. The grayed-out fields become active.
C. Select Share this printer.

D. Make sure that a printer name displays in the Share name field.

o The printer Share name is assigned by the Windows operating system. This
displays as the same printer name (or an abbreviated version of the printer name)
you wrote down earlier.

E. Select Render print jobs on client computers.

F. Click Apply to apply these settings.
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6. Configure security.
o Skip this Configure security section if you want to accept the following defaults:
= All users (the Everyone account) can print.

= Only the person who enabled sharing on the printer (the
CREATOR OWNER account) can view printer error messages at the
client PC.

Users at the client PC can view printer error messages from the Windows
Print Manager. These printer errors can be resolved at the printer LCD screen or
host PC.

For more information, refer to “Security permissions for shared printers” on page
24, and “Setup to view Message boxes” on page 24.

A. Select the Security tab on the Printer Properties window.

B. Review the Group or user names list. Do the following to add users to the
list.

i. Click Add. The Users or Groups dialog box displays.

Select this object type:

|U5ers Object Types... |
From this location:

|HP3G_6 Locations... |

Enter the object names to select {examples):

Clieck Mames

Advanced... | i Cancel

ii. Selectthe name you want to add, and click Add. Repeat for each name
you want to add.

iii. If the names or group do not display in the list, add the names or a
group as follows. Repeat for each name you want to add.

« Click Advanced. The Select Users or Groups dialog box displays.

« Select Object Types.... The Object Types window displays.
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e Click Find Now. A list of user names displays in the search results
section.

e Select each name you want to add.

« Click OK. The Select Users or Groups window displays the names
you selected.
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Select this object type:
IUsers Objsct Types... |
From this location:

|HP3G_6 Locations... |
Enter the object names to select {examples):

HP3IG &\Guest Check Names |

Advanced... | oK I Cancel I
P

iv. When you finish adding names, click OK to close the Users and Groups
dialog box.

C. Inthe Names list, select the name or group to set up.

o Do not select the Manage documents or the Deny check boxes for any user
or group. Select Allow for Manage Printer if you want a user or group to
view message boxes.

i. Select Allow for permissions you want to apply to the user or group.

ii. Clearthe Allow check box for permissions you want to deny the user
or group.

iii. Click Apply to save your changes. Make sure to save changes for each
name.

D. Click OK to close the Printer Properties window.

7. Configure the host PC Printing preferences. Write down the Printing
preferences settings for ribbon type and print resolution.

These settings are not set automatically at the client PC to match the host.
You must enter these settings manually on the client PC. Refer to
“Configuring PC Printing Preferences” on page 47.
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Installing the Card Printer Driver on the Client PC

The client PC may use any of the supported Windows operating systems. See
“Printer Sharing Requirements” on page 22 for a list of supported host/client
operating system combinations. Differences between operating systems are
noted, as needed.

1. Make sure that the Card Printer Driver is installed and set up on the host PC.

o Before you log in to the client PC, review the log in screen. Look for a user
account that matches an account on the host PC. If one is not listed, set up the
user account and password on the client PC.

2. Login to the client PC with a user account that has administrator privileges
and matches an account and password on the host PC.

3. Add the printer to the client PC.
A. Display the Printers window for your system.
B. Select Add a printer. The Add Printer window displays.
C. Windows 7: Select Add a network, wireless, or Bluetooth printer.
A list of available printers displays. Select the printer.
D. If the printer does not display in the list:

i. Select The printer that | want isn’t listed. The Find a printer... page
displays.

i. Enter the name of the host PC and the shared printer name by doing
one of the following:

e Use the names you wrote down during the host PC installation
using the format:

\\host PC name\shared printer name

« |f you don’t have the printer name, enter the host PC name. Use
the format:

\\host PC name\

When you type the last backslash without the printer name, a
drop-down list displays host printers.

Select the shared printer from the drop-down list.

E. Click Next. The message “Do you trust this printer?” may display.
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F. Click Install driver.

The Add Printer page displays and states that you’ve successfully added the
printer.

G. Click Next.

H. Click Finish. The shared card printer icon displays in the Devices and
Printers window of the client PC.

4. |If card production software is installed on this computer, or if you need other
support files, such as magnetic stripe fonts, install the XPS Card Printer Plug-in
or support files from the driver CD. For instructions, refer to “Installing the
Support Files from the Driver CD” on page 15.

5. Configure the client PC printing preferences.

A. Get the printing preferences settings you wrote down at the host PC for
ribbon type and print resolution.

These settings are not set automatically at the client PC to match the host,
so you must enter them manually.

B. From the Devices and Printers window, right-click the card printer icon and
select Printing preferences. The Printing Preferences window displays.

C. Enter the required printing preferences. For instructions, refer to
“Configuring PC Printing Preferences” on page 47.

D. Close the Printing Preferences window.
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